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Abstract

The phase shifted full bridge (PSFB) converter is used for DC-DC conversion in various applications, for
example in telecom systems to convert a high voltage bus to an intermediate distribution voltage, typically
closer to 48V. PSFB stage provides voltage translation as well as isolation from the line voltage, since this
topology includes a transformer.

This document presents the implementation details of a digitally controlled PSFB system implemented on
the HVPSFB kit from Texas Instruments. This kit converts a 400V DC input to a regulated 12V DC output
and is rated for operations up to 600W. Both peak current mode control (PCMC) and voltage mode control
(VMC) implementations are described. These highly integrated microcontroller based realizations feature
adaptive zero voltage switching (ZVS) and various synchronous rectification schemes, which are
discussed here. Details for generating complex gate drive waveforms, required by these control schemes,
and intelligent timing control, to optimize system performance under changing operating conditions, are
provided. A step by step guide to run and get familiar with the HVPSFB project is also included. A
constant high system efficiency above 10% rated load, novel PCMC waveform generation based on on-
chip hardware mechanisms, and simple system implementation are the highlights of this solution.

NOTE: If you would like to quickly evaluate this kit without going through the implementation details,
please follow the accompanying quick start guide (QSG-HVPSB-Rev1.1.pdf) instead of this
document.

2 An IMPORTANT NOTICE at the end of this Tl reference design addresses authorized use, intellectual property matters and other
important disclaimers and information.
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General Texas Instruments High Voltage Evaluation (TI HV EVM) User Safety Guidelines

P\ e

Always follow TI's setup and application instructions, including use of all interface components within their
recommended electrical rated voltage and power limits. Always use electrical safety precautions to help
ensure your personal safety and those working around you. Contact Tl's Product Information Center
http://support/ti./com for further information.

Save all warnings and instructions for future reference.

Failure to follow warnings and instructions may result in personal injury, property damage, or
death due to electrical shock and burn hazards.

The term TI HV EVM refers to an electronic device typically provided as an open framed, unenclosed
printed circuit board assembly. It is intended strictly for use in development laboratory environments,
solely for qualified professional users having training, expertise and knowledge of electrical safety
risks in development and application of high voltage electrical circuits. Any other use and/or
application are strictly prohibited by Texas Instruments. If you are not suitable qualified, you should
immediately stop from further use of the HV EVM.

1. Work Area Safety
(a) Keep work area clean and orderly.
(b) Qualified observer(s) must be present anytime circuits are energized.

(c) Effective barriers and signage must be present in the area where the TI HVY EVM and its interface
electronics are energized, indicating operation of accessible high voltages may be present, for the
purpose of protecting inadvertent access.

(d) All interface circuits, power supplies, evaluation modules, instruments, meters, scopes and other
related apparatus used in a development environment exceeding 50Vrms/75VDC must be
electrically located within a protected Emergency Power Off EPO protected power strip.

(e) Use stable and nonconductive work surface.

(f) Use adequately insulated clamps and wires to attach measurement probes and instruments. No
freehand testing whenever possible.

2. Electrical Safety
As a precautionary measure, it is always a good engineering practice to assume that the entire EVM
may have fully accessible and active high voltages.

(a) De-energize the TI HV EVM and all its inputs, outputs and electrical loads before performing any
electrical or other diagnostic measurements. Revalidate that TI HV EVM power has been safely de-
energized.

(b) With the EVM confirmed de-energized, proceed with required electrical circuit configurations,
wiring, measurement equipment connection, and other application needs, while still assuming the
EVM circuit and measuring instruments are electrically live.

(c) After EVM readiness is complete, energize the EVM as intended.

WARNING: WHILE THE EVM IS ENERGIZED, NEVER TOUCH THE EVM OR ITS ELECTRICAL
CIRCUITS AS THEY COULD BE AT HIGH VOLTAGES CAPABLE OF CAUSING ELECTRICAL
SHOCK HAZARD.

3. Personal Safety

(a) Wear personal protective equipment (for example, latex gloves or safety glasses with side shields)
or protect EVM in an adequate lucent plastic box with interlocks to protect from accidental touch.

Limitation for safe use:
EVMs are not to be used as all or part of a production unit.
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Introduction

Phase shifted full bridge (PSFB) DC-DC converters are used frequently to step down high DC bus
voltages and/or provide isolation in medium to high power applications like server power supplies, telecom
rectifiers, battery charging systems, and renewable energy systems. Traditionally, micro-controllers have
been restricted to only performing supervisory or communications tasks in these systems. With the
availability of high performing micro-controller devices, it is now possible to use micro-controllers for
closing control loops in these systems, in addition to handling the traditional micro-controller functions. The
transition to digital power control means that functions that were previously implemented in hardware are
now implemented in software. In addition to the flexibility this adds to the system, this simplifies the
system considerably. These systems can implement advanced control strategies to optimally control the
power stage under different conditions and also provide system level intelligence.

A PSFB converter consists of four power electronic switches (like MOSFETs or IGBTSs) that form a full-
bridge on the primary side of the isolation transformer and diode rectifiers or MOSFET switches for
synchronous rectification (SR) on the secondary side. This topology allows all the switching devices to
switch with zero voltage switching (ZVS) resulting in lower switching losses and an efficient converter. In
this work, ZVS for switches in the one leg of the full bridge and zero or low voltage or Low Voltage
Switching for switches in the other leg is achieved across the complete load range, by changing dead-
times for primary side switches based on load conditions.

For such an isolated topology, signal rectification is required on the secondary side. For systems with low
output voltage and/or high output current ratings, implementing synchronous rectification instead of diode
rectification achieves the best possible performance by avoiding diode rectification losses. In this work,
current doubler synchronous rectification is implemented on the secondary side with different switching
schemes to achieve optimum performance under varying load conditions.

A DC-DC converter system can be controlled in various modes like voltage mode control (VMC), average
current mode control (ACMC) or peak current mode control (PCMC). Implementing these different control
modes for controlling the same power stage typically requires redesigning the control circuit along with
some changes to the power stage sensing circuit. With a microcontroller based system, all these modes
can be experimented with on the same design with minimal or no additional changes. Such a system is
implemented here using VMC and PCMC control schemes.

PCMC is a highly desired control scheme for power converters because of its inherent voltage feed
forward, automatic cycle by cycle current limiting, flux balancing and other advantages. Implementing
PCMC for a PSFB system requires complex PWM waveform generation with precise timing control. A new
approach to this waveform generation is presented using TMS320F2802x and TMS320F2803x (Texas
Instruments Piccolo series) microcontrollers without requiring any additional support circuitry. Unique
programmable on-chip slope compensation hardware is used to provide appropriate slope compensation
that guarantees open loop stability and eliminates/limits sub-harmonic oscillations at the output. For
PCMC implementation with a micro-controller, the regulated output voltage is dependent on the amount of
output voltage ripple, which in turn is dependent on the load. This relation is explained in detail and
different solutions are suggested.

Peak efficiency greater than 95% and efficiency greater than 90% down to 10% load is achieved with the
600W PSFB system used here.
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1.1 Basic Operation

Figure 1 shows a simplified circuit of a phase shifted full bridge. MOSFET switches QA, QB, QC and QD
form the full-bridge on the primary side of the transformer T1. QA and QB are switched at 50 % duty and
180 degree out of phase with each other. Similarly, QC and QD are switched at 50 % duty and 180
degree out of phase with each other. The PWM switching signals for leg QC — QD of the full bridge are
phase shifted with respect to those for leg QA - QB. Amount of this phase shift decides the amount of
overlap between diagonal switches, which in turn decides the amount of energy transferred. D1, D2
provide diode current doubler rectification on the secondary, while Lo and Co form the output filter.
Inductor LR provides assistance to the transformer leakage inductance for resonance operation with
MOSFET capacitance and facilitates Zero Voltage Switching (ZVS). Note the two different grounds G1
and G2 on the two sides of transformer T1. Figure 2 provides the switching waveforms for the system in

Figure 1.
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Figure 1. A Phase-Shifted Full Bridge Circuit
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Figure 2. PSFB PWM Waveforms
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1.2

PSFB Implementation on HVPSFB Board

Figure 3 shows a simplified block diagram of the PSFB circuit implemented on the HVPSFB board.
Switches QA, QB, QC and QD in Figure 3 correspond to switches Q1, Q4, Q2 and Q3 respectively.
Switches Q5 and Q6 are used for synchronous rectification on the secondary.
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Figure 3. PSFB System Block Diagram

The control algorithm is implemented on a C2000 microcontroller (MCU). The MCU interacts with the
PSFB power stage by way of feedback signals and PWM outputs. The controller is placed on the
secondary side on this design. Deciding on the placement of the controller with respect to the isolation
boundary is a crucial step when designing an isolated DC-DC system. For systems that have multiple
output rails or handle many signals and control loops on the secondary side or communicate with other
systems in the application (on the secondary), placing the controller on the secondary side is more
advantageous.

Phase shift between PWM signals driving the two legs of the full bridge determines the amount of energy
transferred to the load. This phase shift is the controlled parameter.

MCU achieves DC — DC conversion by controlling this phase shift so as to regulate and maintain the
output voltage at the commanded level.

Controlling such a system in different operation modes requires generating complex PWM drive
waveforms along with fast and efficient control loop calculations. This is made possible on C2000
microcontrollers by advanced on-chip control peripherals like PWM modules, analog comparators with
DAC and slope compensation hardware and 12-bit high speed ADCs coupled with an efficient 32-bit CPU.
A detailed description of the software algorithm is provided in the following chapters.
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Design Features

400V DC input (370Vdc to 410Vdc operation), 12V DC output

Peak efficiency greater than 95%. Above 90% efficiency down to 10% load

50 Amp (600 Watt) rated output

Phase Shifted Full-Bridge Circuit topology

100 KHz switching frequency

Peak Current Mode Control (PCMC) with no external support circuitry for PCMC function
Multiple Synchronous Rectification (SR) switching schemes

Adaptive ZVS/LVS across the complete load range

Efficient GUI Interface that allows fast & easy system tuning for optimal performance
Fault protection: Input UV and OV, Over-current, Output UV (CC/CP mode)
Constant current (CC) and constant power (CP) functions

Optional Voltage Mode Control (VMC)

6
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1.4 Test Results
Following provides some results obtained using this kit:

HVPSFB 600W EVM - Efficiency
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(1) Note that the auxiliary power is not included in the efficiency calculations.
Figure 4. Efficiency Vs. Load (PCMC and VMC Implementations)

A Load = 12A A Load =12A

Figure 5. Active to Passive Leg Transitions (ZVS) Figure 7. Passive to Active Leg Transitions (LVS)
Switching Switching

00:33:10

Figure 6. PCMC Transient Response (0% to 80% Figure 8. PCMC Transient Response (80% to 0%

Load Step) Load Step)
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ZVS and/or LVS switching are achieved across the complete operating range. System efficiency of more
than 90% is obtained for all loads greater than 10% rated load, while the peak efficiency is greater than
95%. Output peak deviations of less than 3% of rated output and settling times less than 250us are
achieved for 80% step change in load. PCMC step response looks like a damped first order system. This
C2000 MCU (TMS320F2802x) based implementation provides an ability to generate, and control, complex
gate drive waveforms required for PCMC and VMC control schemes while still providing a level of
intelligence unique to digitally controlled solutions.

Following provides a snhapshot of the PCMC GUI included in the software package accompanying this kit.
A separate GUI for VMC implementation is also included.
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Figure 9. PCMC GUI
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1.5 Identifying Key Components on the Board
Figure 10 shows key hardware components.
TMS320F28027
Controller card HOVEG Input
Full Bridge
ﬁ Jumper J6
Synchronous
Rectifiers
Resistor R6 |
and J1 for 3§
boot config
PCMC and VMC PM
drive jumper enables
Jumper J8
400V to 12V Aux
Power Module
Figure 10. HVYPSFB Development Kit
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Figure 11 and Figure 12 provide the schematic diagram for the Piccolo-A controller card and the HYPSFB base board.
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Figure 11. MS320F28027(Piccolo-A) Controller Card Schematic
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2 Functional Description

2.1 Peak Current Mode Control (PCMC)

Implementing PCMC for a PSFB system requires complex PWM waveform generation with precise timing
control. The Piccolo family of devices from Texas Instruments feature advanced on-chip control
peripherals that make this implementation possible without any external support circuitry for this purpose.
These peripherals include on-chip analog comparators, digital to analog converters (DAC), advanced
PWM resources and unique programmable on-chip slope compensation hardware. Figure 13 provides a
block diagram representation of the PCMC implementation. Transformer primary current is compared with
the peak current reference calculated by the voltage loop using the on-chip comparator 1. As shown in
Figure 14, in every half of the switching cycle when the transformer primary current reaches the
commanded peak reference value, one of the PWM waveforms driving the switches (Q2/Q3) is ‘Reset’
immediately ending the power transfer phase. The PWM waveform driving the other switch in the same
leg is ‘Set’ after a programmable dead-time (dead-band) window. Appropriate slope compensation is also
applied that adds a ramp with a programmable negative slope to the peak reference current signal. The
‘Resetting’ and ‘Setting’ action of the PWMs in one leg results in a phase shift between PWM signals
driving the two legs. The amount of this phase shift, and thereby the overlap between diagonal switches,
is dependent on the amount of peak reference current. Higher the peak reference current, longer the
overlap between diagonal switches, and thereby, more the energy transferred to the secondary. The
controller regulates the output by controlling this energy transfer by way of controlling the peak reference
current value. Thus this peak reference current is the controlled parameter.

An important feature of this implementation is that the same peak reference current command is used for
both halves of the switching cycle under all operating conditions. This provides optimal flux balance for the
transformer primary reducing any chances of saturation.

100 KHz
ePWM1A
CNTL 2P2Z >
DAC PWM1B
—®| Ref  Out[——» 1;);;;;; . —
Current | Comp o ePWM2A
> Fdbk ICommand M
Voltage . ePWM2B
Controller Analog H
Gomp W | ePWM4A
—>
dbAtoP — ePWM4B
—>
dbPtoA —
100 KHz
A | NO
' — lpri rsit0 - l«—
ADC C | _IN1
Vfb_out It1
_ou rs S ' l«—
DRV
<«— Vfb_in rslt2 w <—|N2
Figure 13. PCMC Block Diagram
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Figure 14. PCMC PWM Waveforms

2.2 Voltage Mode Control (VMC)

In the VMC implementation, switches in each leg are driven with complementary pulse width modulated
(PWM) signals of fixed (50%) duty cycle and frequency. As shown in Figure 15, the controller directly
drives and controls the phase shift of PWM signals driving switches in one leg of the bridge with respect to
the ones driving switches in the other leg. This phase shift dictates the amount of overlap between
diagonally opposite switches, which is clear in Figure 16. Longer the overlap between diagonal switches,
longer the amount of time the input voltage is imposed across the transformer primary winding, and,
thereby, larger the amount of energy transferred to the secondary. The controller regulates the output by
controlling this energy transfer by way of directly controlling the phase shift between the PWM signals
driving the two legs. Thus this phase shift is the controlled parameter. It should be noted that with VMC
implementation there is a need to include a DC blocking capacitor in the transformer primary to avoid
possible transformer saturation from flux imbalance over time. Therefore, jumper J6 in Figure 10 should
be removed for the VMC implementation.
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Figure 16. VMC Waveforms
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2.3

2.4

2.5

Zero Voltage Switching (ZVS) or Low Voltage Switching (LVS)

PSFB DC-DC converters make use of parasitic elements in the circuit to ensure zero voltage across the
MOSFET switches before turning them ON, providing soft switching. This considerably reduces the
amount of switching losses associated with hard switching.

For the system discussed here, switching transitions for switches in the Q2- Q3 leg end the power transfer
interval. Therefore this leg is called the ‘Active to Passive’ leg. When transitions occur for switches in this
leg, current in the primary winding is close to its maximum magnitude for that half PWM switching cycle.
The reflected load current aids the circulating energy in the primary circuit during this time, which makes it
possible for voltage across switches in this leg to approach zero volts. It is possible to achieve ZVS for
switches in this Q2-Q3 leg across the complete load range. It should be noted that as the load decreases
the amount of dead-time needs to be increased to achieve/approach ZVS.

Switching transitions for switches in the Q1- Q4 leg start the power transfer interval. Therefore this leg is
called the ‘Passive to Active’ leg. During these switching transitions, primary current decreases. It crosses
zero current value and changes direction. This results in lower available energy for ZVS. In fact for
operations under low load conditions, voltage across these switches may not go to zero before turning
them on. Switching losses can be kept to a minimum by turning these switches ON at a time when the
voltage across them is at a minimum. This is called Low Voltage Switching or low voltage switching (LVS).
As the load changes the time at which the switch should be turned on to achieve LVS changes, requiring
dead-time adjustment similar to the Q2-Q3 leg switches.

Synchronous Rectification

Synchronous rectifiers can work in one of the following three modes at any given time:

1. Mode 0: This is the classical diode current doubler mode achieved by keeping synchronous rectifiers
turned OFF. It is useful for very low load operations where synchronous rectifier switching losses are
greater than the power savings obtained by synchronous rectification.

2. Mode 1: In this mode the synchronous rectifier switches behave like ideal diodes. This mode is useful
when operating at very low to low loads, typically when burst mode is being used. In this mode,
synchronous rectifier MOSFETSs are ON only when the corresponding diagonal bridge drive signals
overlap.

3. Mode 2: Useful for all other load conditions. In this mode, synchronous rectifier MOSFETs are OFF
only when the corresponding opposite diagonal bridge drive signals overlap.

Figure 14 and Figure 16 depict waveforms generated for driving the synchronous rectifier switches in
these modes. It is important to implement mode transitions seamlessly without any glitches or anomalies
on the PWM outputs even during large load transients or sudden phase shift change commands to ensure
safe operation of the system.

Output Voltage Regulation with Changing Load

The regulated output voltage is affected by changing load conditions. This problem exists because of
ripple on the output voltage that appears at two times the switching frequency. At low loads, peak-to-peak
voltage ripple is relatively small, while at higher loads it increases considerably. If the ADC conversions
are triggered at a fixed point within a switching cycle, as shown in Figure 17, the sensed ADC voltage
result is smaller at high loads (for the same average voltage). This is shown below:

Output
Voltage

Low Load/ \High Load

Lower Ripple

ADC triggered at
same point

Figure 17. Effect of Fixed-Point ADC Conversion Triggering for Output Voltage Sensing
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Thus, for same average output voltage, a smaller output voltage is seen by the controller under high-load
operation. The controller compensates for this AVadc, which results in an increase in the actual output
voltage value as the load increases. A few possible solutions to minimize this effect are suggested here.

1. Start of ADC conversion can be triggered at an appropriate time in every half PWM switching cycle so
as to directly sense the average output voltage. With PCMC implementation, duty cycle is not pre-
determined and hence this trigger point is unknown. This method works very well with VMC.

2. Average output voltage can be calculated at a slow rate and an outer slower loop can be used to
adjust voltage reference or feedback. However, this may affect the dynamic performance.

3. The average output voltage can be calculated on a cycle-by-cycle basis by over-sampling it over one
or two ripple cycles. Since the average output voltage is calculated over a full ripple cycle, any effects
from higher/lower peak-to-peak ripple are avoided. Also, since the average is calculated in one or two
ripple cycles and used for the next PWM switching cycle, the dynamic behavior and control loop
performance do not suffer much. With this method multiple ADC conversions are required within a
single PWM half cycle. This is the method recommended here for PCMC implementation. In this
implementation the output voltage is oversampled eight times within a PWM switching cycle.

4. Increased filtering at the ADC input can attenuate the ripple and reduce AVadc. However, this affects
system dynamic performance and achievable loop bandwidth, while the output voltage behavior still
remains the same.
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3 Software Overview - PCMC

3.1 Software Control Flow

The HVPSFB_PCMC project makes use of the “C-background/ASM-ISR” framework. It uses C-code as
the main supporting program for the application, and is responsible for all system management tasks,
decision making, intelligence, and host interaction. The assembly code is strictly limited to the ISR
(Interrupt Service Routine), which runs all the critical control code and typically this includes ADC reading,
control calculations, and PWM and DAC updates. Figure 18 depicts the general software flow for this

project.
C Environment Assembly
Context Save
Initialization
28x Device level
Peripheral level Counting Down Tg?:e[\?_lh Counting Up
Systerm level direction
ISR, ADC = Timing critical tasks = Timing critical tasks
= Reconfigurations for next ISR = Reconfigurations for next ISR
‘ | Background Loop | | ADCDRY _dch (Vout) ADCDRY _dch (out)
ADCDRY_1ch (lout ey e i
et fout) ADCDRY Tch (Vibin)
| Average of B Vout samples | | Summation of 4 Yout Samples |
Background Loop
| CMTL_2P2Z (if closed loop) | | DACDRY _RAMP |
Timer 1 Tasks: Timer 2 Tasks: Timer 3 Tasks:
- Communications » Inistritne Atation = Soft-stat/shut-down ontext Restore
= Yloop Slew limit * Auto DB adjust
» 2P27 coeffcale I BT I

Figure 18. PCMC Software Flow

The key framework C files used this project are as follows:

« HVPSFB-Main.c — This file is used to initialize, run, and manage the application. This is the “brains”
behind the application.

» HVPSFB-Devlnit.c — this file is responsible for a one time initialization and configuration of the micro-
controller, and includes functions such as setting up the clocks, PLL, GPIO, etc.

The ISR consists of a single file:

 HVPSFB-DPL-ISR.asm - this file contains all time critical “control type” code. This file has an
initialization section (one time execute) and a run-time section which executes at twice the PWM
switching frequency.

The Power Library functions (modules) are “called” from this framework. Library modules may have both a
C and an assembly component. In this project, following library modules are used. The C and
corresponding assembly module names are:
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Table 1. Library Modules

C configure Function

ASM Initialization Macro

ASM Run-Time Macro

DAC_Cnf.c

DACDRV_RAMP_INIT n

DACDRV_RAMP n

ADC_SOC_Cnf.c

ADCDRV_4CD_INIT m, n, p, q

ADCDRV_4CHm, n, p, q

ADC_SOC_Cnf.c

ADCDRV_1CH_INIT n

ADCDRV_1CH n

CNTL_2P2Z_INIT n

CNTL_2P2Z n

The control blocks can also be represented graphically, as shown in Figure 19.

CNTL_2P2Z:1:

Ref

VfbSetSlewed
Avg_Vout

Dmax

ADCDRV_4ch:1,4,6,8:

RItPtrA

0 RItPtrB
01 RltPtrC

£1 RItPtrD

€— ADC A0

ng»>

««— ADC A0

RItPtrA
RItPtrB
RItPrC
RItPtrD

DACDRV_RAMP:1:

1 DACDRV_RAMP_In:n:

—» RAMPMAXREF
> owon |

ADCDRV_4ch:1,4,6,8:

«¢— ADC AQ

€— ADC A0

NI >

««— ADC A0

«— ADC A0

Figure 19. PCMC Software Blocks

ADCDRV_1ch:2:

ADC A Adc_lfb 0 ADCDRV_1ch_RIt ‘ ADC <«— ADCA2

ADCDRV_1ch:3:

Adc_Vfbin B ADCDRV_1ch_RIt ‘ ADC «¢— ADC B1

ADCDRV_1ch:9:

€— ADCA0
Adc_lout 01 ADCDRV_1ch_RIt ‘ ADC «¢«— ADC B4

Notice the color coding for modules in Figure 19. Blocks in ‘dark blue’ represent hardware modules on the
C2000 micro-controller. Blocks in ‘blue’ are the software drivers for these modules. Blocks in ‘yellow’ are
the controller blocks for the control loop. Although a 2-pole 2-zero controller is used here, the controller
could very well be a PI/PID, a 3-pole 3-zero or any other controller that can be suitably implemented for
this application. Such a modular library structure makes it convenient to visualize and understand the
complete system software flow as shown in Figure 20. It also allows for easy use and additions/deletions
of various functionalities. This fact is amply demonstrated in this project by implementing an incremental
build approach. This is discussed in more detail in Section 3.2.
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- ISR ePWM1A
100Khz e  Timing Critical Tasks > —>
100Khz — Reconfigurations for next ISR
CNTL_2P2Z:1: DACDRYVEROME:T: PWM1B
> {rupiEF > DG :
—{_Iref 0 DACDRV_RAMP_In:n: 10-bit + P ePWM2A
> oo | oo w
Comp ]
ePWM2B
H
w ePWM4A
—>
~ 2 dbAtoP — ePWM4B
g Difiax 100Khz —
2 100Khz [ ADCDRV_achi1,4,6,8: dbPtoA —)
< RIEPrA l€— ADC A0
100Khz
° RItPtrB A [€— ADC AO [ ADCDRV_Ich:2:
i RItPHC C |€— ADC A0 AV IEIAE ‘ ADC [€— ADCA
=
S RItPtD |€— ADC A0 100Khz
% [ ADCDRV_1ch:3:
=
= 100Khz ADCDRVJch,R]t ‘ ADC «€— ADCB
g ADCDRV._4ch:1,4,6,8:
] RItPrA 100Khz
5 €— ADC A0 [ ADCDRV_1ch:0:
(5]
& RI(PHB A [ ADC A0 ADCDRv,lch,RIt ‘ ADC (€— ADCB
E D
RItPrC C €— ADCA0
RIEPtrD €— ADC A0

Figure 20. PCMC Control Flow

The system is controlled by two feedback loops; an outer voltage loop, implemented using software
control block, and an inner peak current loop, implemented using the on-chip analog comparator, DAC
and PWM hardware resources. Figure 20 also gives the rate at which control blocks are executed. For
example, the voltage loop controller is executed at a rate of 100 kHz (same as the PWM frequency). Note
that the interrupt service routine (ISR) is executed at twice the PWM frequency. Following explains the
control implemented above.

Output voltage is sampled at four points, equally separated from each other in time, in each half of the
PWM switching cycle. The average (Avg_Vout) of these output voltage samples is calculated over one
PWM cycle. Avg_Vout is compared with slewed version (VfbSetSlewed) of the voltage reference
command (Vref) in the voltage controller. The voltage controller output is then translated to an appropriate
DAC command. This is the peak current reference command that eventually dictates the amount of phase
overlap between the two legs of the full bridge to regulate the output voltage. ‘Slope’ value for the slope
compensation mechanism can be programmed from outside the control flow in slower system level tasks.
A default slope of at least 0.04V/us is provided (Please refer to calculations provided in [1], [2] and [4].
The on-chip analog comparator compares the transformer primary current with the slope compensated
peak current reference. Comparator output directly drives the PWM hardware on the device. Some time
critical configuration code is executed inside the ISR, which is triggered twice in one PWM cycle. The
dbAtoP and dbPtoA parameters provide dead band values for the ‘Active to Passive’ and ‘Passive to
Active’ legs of the full bridge, respectively. These are used to achieve ZVS/LVS across the load range.
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3.2 Incremental Builds

This project is divided into two incremental builds. This makes it easier to learn and get familiar with the
board and the software. This approach is also good for debugging/testing boards.

The build options are shown below. To select a particular build option, set the macro INCR_BUILD, found
in the HVPSFB-Settings.h file, to the corresponding build selection as shown below. Once the build option
is selected, compile the complete project by selecting rebuild-all compiler option. Next chapter provides
more details to run each of the build options.

Table 2. Incremental Build Options

Incremental Build Options

Peak current loop check with constant | command and open
voltage loop (Check PWM drive circuit and sensing circuit)

INCR_BUILD =1

INCR_BUILD =2 Closed current and voltage loop (Full PSFB)
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4

4.1

41.1

4.1.2

Procedure for running the incremental builds - PCMC

The main source files, ISR assembly file and the project file for C framework to bring up the PSFB system
are located in the following directory (please use the latest version of the software package. Version 1.1 is
the latest software version as of March

2012) ..\controlSUITE\development_kits\HVPSFB_v1.1\HVPSFB_PCMC. The projects included with this
software are targeted for CCSv4.

Follow the steps below to build and run the example included in the HYPSFB_PCMC software.

CAUTION

There are high voltages present on the board. It should only be handled by
experienced power supply professionals in a lab environment. To safely
evaluate this board an appropriate isolated high voltage DC source should be
used. Before DC power is applied to the board a voltmeter and an appropriate
resistive or electronic load must be attached to the output. The unit should
never be handled when the power is applied to it.

Build 1: Peak Current Loop Check with Open Voltage Loop

Objective

The objective of this build is to evaluate the peak current mode operation of the system, verify the DAC
and ADC driver modules, verify the MOSFET driver circuit and sensing circuit on the board and become
familiar with the operation of Code Composer Studio (CCS). Since this system is running open-loop, the
ADC measured values are only used for instrumentation purposes in this build. Steps required to build and
run a project will be explored.

Overview

The software in Build1 has been configured so that the user can quickly evaluate the DAC driver module
by viewing various waveforms on an oscilloscope and observing the effect of change in peak current
reference command on the output voltage by interactively adjusting this command from CCS. Additionally,
the user can evaluate the ADC driver module by viewing the ADC sampled data in the watch view.

The DAC and ADC driver macro instantiations are executed inside the _DPL_ISR as mentioned in the
previous chapter. Figure 21 shows the blocks used in this build. The peak current reference command is
written to the DACDRV_RAMP module. This module derives an appropriate 16-bit value
(RAMPMAXREF)), which is the starting value of the RAMP used for slope compensation. This module
also drives an appropriate 10-bit value to the DACVAL register, which can be used if slope compensation
is not needed or provided externally. The on-chip analog comparator compares the transformer primary
current with the slope compensated peak current reference. Comparator output is connected to the trip
zone logic of the PWM modules. ePWM1 module acts as the master time-base for the system. It operates
in up-down count mode, while other PWM modules operate in up-count mode. ePWM1A and ePWM1B
drive Q1 and Q4 full-bridge switches, while ePWM2A and ePWM2B drive Q2 and Q3 full-bridge switches.
ePWM4A and ePWM4B drive Q5 and Q6 synchronous rectifier switches. Whenever the comparator output
goes high in a PWM half cycle, the ePWM2 module output (ePWM2A or ePWM2B) which was high at that
instant is immediately pulled low while the other PWM2 module output is pulled high after an appropriate
dead-band window (dbAtoP). ePWM4A and ePWM4B outputs are driven in a similar way. These
waveforms are shown in Figure 14.

It should be noted that this slope compensation ramp generation, comparator action and PWM waveform
generation are all hardware generated without any software involvement as denoted by the dark blue
blocks in Figure 21. Some register reconfigurations are done inside the ISR in preparation for the next half
of the PWM cycle. This time critical code executes at the start of the ISR and should not be re-ordered or
changed. The assembly ISR _DPL_ISR routine is triggered by ePWM1. Note that the ISR trigger
frequency is twice that of the PWM switching frequency.
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Figure 21. Build 1 Software Blocks

The RAMPMAXREF and DACVAL values are derived from the input “Iref” (Q24 variable) command.
Table 3 gives example RAMPMAXREF and DACVAL values calculated from ‘Iref’.

Table 3. Example RAMPMAXREF and DACVAL Values

Iref (Q24) Ry acaA oy DACVAL = (Iref/2714) e
2097152d 8192 128 0.845A
8388608d 32768 512 3.39A
16776704d 65534 1023 6.77A

The ADC driver modules are used to read 12-bit ADC results and convert them to Q24 values. In every
half PWM cycle PWM1 SOCA (start of conversion A), PWM3 SOCA (start of conversion A) and PWM3
SOCB (start of conversion B) are used to trigger four ADC conversions for the output voltage. These
conversion trigger points are equally separated from each other in time. These four results are read in
every ISR thus providing a total of eight ADC conversion results of the output voltage within every PWM
cycle. A few lines of code in the ISR are used to calculate the average output voltage over one PWM
cycle based on these eight results.

The output voltage sensing circuit is made up of simple voltage dividers. A current transformer, with a
turns-ratio of 1:100, and a sense resistor (48.7 ohm) are used to sense the full-bridge transformer primary
current. The input voltage sensing is provided by auxiliary power module (J7). Please refer to HVPSFB-
Calculations.xls file for details on these calculations.
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4.1.3 Protection

At this stage, it is appropriate to introduce the shutdown mechanism used on this board. Here overcurrent

protection is implemented for the transformer primary current using on-chip analog comparator 2. The

reference trip level is set using the internal 10-bit DAC and fed to the inverting terminal of this comparator.
The comparator outputs are configured to generate a one-shot trip action on ePWM1 whenever the
sensed current is greater than the set limit. The flexibility of the trip mechanism on C2000 devices

provides the possibilities for taking different actions on different trip events. In this project ePWM1A and
ePWM1B outputs are driven low immediately to protect the power stage. ePWM2A, ePWM2B, ePWM4A
and ePWm4B outputs are then forced low from software. All outputs are held in this state until a device

reset is executed. Please refer to HYPSFB-Calculations.xls file for details on these calculations.

An output under voltage shut down mechanism is also implemented from the software when operating

under constant current or constant power modes.

Input under voltage and over voltage lockout is also implemented in the software.

41.4 Resource Mapping

The key signal connections between the C2000 MCU and the HVPSFB stage are summarized in Table 4.

Note that PWM mapping is different between VMC and PCMC projects. Jumper (J2, J3 — PCMC and VMC
PWM drive jumper enables) on the controller card need to be correctly configured for VMC mode (Default

jumper positions are set for PCMC operation). Here are the jumper configurations for the two modes:

PCMC: J2(1) -> J3(1), J2(2) -> J3(2), J2(3) -> J3(3), J2(4) -> J3(4), J2(7) -> I3(7), J2(8) -> J3(8),
VMC: J2(1) -> J3(3), J2(2) -> J3(4), J2(3) -> J3(1), J2(4) -> I3(2), J2(7) -> I3(8), J2(8) -> I3(7)

Table 4. HVPSFB Signal Interface Reference -PCM

Signal Name Description Connection to C2000 Controller
ePWM-1A PWM Dirive for full-bridge switch Q1 GPIO-00
ePWM-1B PWM Dirive for full-bridge switch Q4 GPIO-01
ePWM-2A PWM Dirive for full-bridge switch Q2 GPI0-02
ePWM-2B PWM Dirive for full-bridge switch Q3 GPIO-03
ePWM-4A PWM drive for synchronous rectifier switch Q5 GPI0O-06
ePWM-4B PWM drive for synchronous rectifier switch Q6 GPIO-07

Vout PSFB output voltage ADC-AO0
Ifb Transformer primary current ADC-A2/COMP1A
Ifb Transformer primary current ADC-A4/COMP2A®
Vfbin PSFB input voltage ADC-B1
loutl PSFB output current ADC-B3
lout2 PSFB output current (heavily filtered) ADC-B4

@ Default jumper J4 configuration on controller card. Input is configurable by jumper J4 selection.

NOTE: The HVPSFB_PCMC and HVPSFB_VMC projects use DSP2802x_Comp.h and
DSP2802x_EPWM.h header files that are located in their own project directories instead of
the ones located in the device_support directory. The two files in device_support directory
will be updated at a later update of ControlSuite, at which time these updated files may be
used with the two projects.

TIDU248-May 2014
Submit Documentation Feedback

Phase-Shifted Full Bridge DC/DC Power Converter Design Guide

Copyright © 2014, Texas Instruments Incorporated

23


http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDU248

13 TEXAS
INSTRUMENTS

Procedure for running the incremental builds - PCMC www.ti.com

415 Procedure

415.1  Start CCS and Open a Project

To quickly execute this build, follow the following steps:
1. Ensure that jumpers J8 and J6 on the base board are populated.

2. By default, resistor R6 on Piccolo Macro of the controller card and jumper J1 are removed to enable —
boot from FLASH. Re-populate these two to run and program RAM or program FLASH. Connect USB
connector to the Piccolo controller card for emulation. Use of an appropriate isolated DC power supply
set to output around 400V DC is recommended. DC power supply should remain off when it is
connected to J1 and J2 on the main board. Use a 20AWG 600V wire to connect the Power Source to
J1 and J2. Make sure that polarity of this connection is correct. Apply an appropriate resistive/DC
electronic load to the phase shifted full bridge system at the DC output at J3 and J4. Do not turn on
400V DC power at this time. Power up the bias supply between TP1 and TP2 with around 11V DC
(this voltage must be less than 12V).

3. Double click on the Code Composer Studio icon on the desktop. Maximize Code Composer Studio to
fill your screen. Close the Welcome screen if it opens up.

4. A project contains all the files and build options needed to develop an executable output file (.out)
which can be run on the MCU hardware. On the menu bar click: Project -> Import Existing CCS/CCE
Eclipse Project and under Select root directory navigate to and
select ..\controlSUITE\development_kits\HVPSFB_v1.1\HVPSFB_PCMC directory. Make sure that
under the Projects tab HYPSFB_PCMC is checked. Click Finish.

This project will invoke all the necessary tools (compiler, assembler, linker) to build the project.

5. In the project window on the left, click the plus sign (+) to the left of Project. Your project window will
look like the following:

= 125 HVPSFB_PCMC [Active - F28023_FLAS!
ties

des

F2802x_FLASH
DSP2802x_Comp.h
DSP2802x_EPwm.h
HWPSFB-Setti h
ADC_SOC.
DAL c
DSP200Zx_CodestartBranch.asm
@ DsP2802x_
DSP2802x_
HVPSFE-D:
HYPSFB-CF
HUVPSFE-1

P EPERE R EPEEEE o

t
4
]

a

& consols 52 & G|
‘C-Build [HYPSFB_PCMC]
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41.5.2

Device Initialization, Main, and ISR Files

NOTE: Do not make any changes to the source files — Only Inspect

Open and inspect HVPSFB-DevInit_F2802x.c by double clicking on the filename in the project window.

Notice that system clock, peripheral clock prescale, and peripheral clock enables have been setup.
Next, notice that the shared GPIO pins have been configured.

Open and inspect HVPSFB-Main.c. Notice the call made to Devicelnit() function and other variable

initialization. Also notice code for different incremental build options (specifically the build you are going
to compile now), the ISR intialization and the background for(;;) loop.

Locate and inspect the following code in the main file under initialization code specific for build 1. This

is where the DACDRV_RAMP block is connected and initialized in the control flow.

Dachrvinf (1,

// DAC ponnections

1zs0,

lJ' 2!’

DACDREY RAMP Inl = &£Iref;

Zlope)

/4 Compl,
/¢ Rawp is PUM3 Synced,

DACwval

1280 (Initial),
Initial Slope

3lope compensation is used,

Jf Controls the DAC reference voltage

4. Locate and inspect the following code in the main file under initialization code specific for build 1. This
is where the ADCDRV_4CH and multiple instantiations of ADCDRV_1CH blocks are configured,
initialized and connected in the control flow.

fdefine WEb_outR AdcResu
#define IfbR AdeResu
#define Wikh_inR AdeResu
#define IoutR AdcResu

1t
1t
1t

1t

.ADCRESULTL 7
.LDCRESULTZ I
. LDCREZULT: I
. ADCRESULTS 17

/¢ Channel Selection for Cascaded Sequehcer

Chgel[0] = O; 4
ChSel[1] = 0; //B i
ChsSel[2] = 2; I
ChSel[3] = 9 i
Ch3el[4] = O; Fic 4
ChZel[5] = O0; I
Chsel[6] = 0: //R i
Ch3el[7] = O: 4
Chgel[8] = O; £4D 4
/4 ChIel[9] = 11; /7
ChSel[9] = 1Z; I

Trig3el[0]
TrigSel[1]
Trig3el[Z]
Trigdel[3]
Trigdell4]

Trigdel[5]
Trigdel[6]
TrigSel[7]
Trig3el[3]

Trig3el[9]

ELLLOW;

AdeRegs . SOCPRICTL.bit .IOCPRICORITY = 3:

ERIS;

ADC_30OC_CHNF (Ch3el,Trigdel,ACOFPE, 16, 0O);

an

ADCTRIG_EFWMI_SOCA:
ADCTRIG EPWM3 SOCA:

ADCTRIG_EFWH3

SOCA;

ADCTRIG_EPWHI_SOCA:
ADCTRIG_EPWHI_SOCA:

ADCTRIG EPWM1 SOCA:
ADCTRIG_EFWH1_ SOCA:

ADCTRIG_EFPWHI

S0CE:

ADCTRIG_EFWMI_SOCE:

ADCTRIG_EFWHZ SHOCA:

#/ ADC feedback connections

- O/P Voltage - Doy

- O/F Voltage
Transformer Primary Current

- I/P
- ofF
Q/P
a7 F
/P
/P
Ioutl
Iout2

i
£
£
i
i

/4B

fic

£
£
i
i

IS

A0

£

£

£
i

Voltage
Woltage
Voltage
Voltage

ADCDRV_4ch RLEFtri
LDCDRV_4ch_RItPteB
LDCDRV_4eh RIEPEEC
ADCDRV_4ch RLEFtrD

Ehde VavgBus([1]
cide_VavgBus[2];
&hde_VavgBus[3]:
Ehde VavgBus([4]

ADCDRV_1eh Rltz = shde_Ifh:
ADCDRV_lch RlE3 = sghde Vibing
ADCDRV_1ch R1tS = ghde_Iout:

Voltage
Voltage

O/F Voltage
O/F Voltage
Transformer
/P
/e

Voltage
Voltage

QP
ofP
ofP
o/F

Voltage
Voltage
Voltage
Voltage

- Dy

— Durny

sawpling triggered by EPWHM3 S0CAL - Doy

sawpling triggered by EPWMI

S0CA

FPrimary Current sampling triggered by EPWM3 30CA

sampling triggered hy EPWME
sampling triggered by EPWHMI

sampling triggered by EPWHM1
sampling triggered by EPWM1
sampling triggered by EPWHM3
sawpling triggered by EPWHMI

Iout triggered by EPWMZ 3Z0CAh

S0C0-8 are high priority

30CA
S0CL

FOCA
30CA
30CE
SOCE

at CTR = ZRD or PRD - Duwmmy
at CTR = ZRO or PRD

at CHMPB3 - Durmy

at CHMFE3

ACOP3=5, Mo ADC channel triggers an interrupt IntChZ3el > 15,
Mode= Start/Stop (0}

5. Open and inspect HYPSFB-DPL-ISR.asm. Notice the _DPL_Init and _DPL_ISR sections. This is where
the DAC and ADC driver macro instantiation is done for initialization and runtime, respectively.

Optionally, you can close the inspected files.
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4.1.5.3 Build and Load the Project

1. Select the Incremental build option as 1 in the HYPSFB-Settings.h file.

NOTE: Whenever you change the incremental build option in HVPSFB-Settings.h always do a
“Rebuild All”.

2. Click Project -> “Rebuild All” button and watch the tools run in the build window.

3. Click Target -> "Debug Active Project”. CCS will ask you to open a new Target configuration file if one
hasn’t already been selected. If a valid target configuration file has been created for this connection
you may go to Step 5. In the New target Configuration Window type in the name of the .ccxml file for
the target you will be working with (Example: xds100-F28027.ccxml). Check “Use shared location” and
click Finish.

4. In the .ccxml file that opens up select Connection as “Texas Instruments XDS100v2 USB Emulator”
and under the device, scroll down and select “TMS320F28027". Click Save.

5. Click Target -> "Debug Active Project”. The program will be loaded into the FLASH or RAM memory
depending on the project configuration selected. This project comes in only F2802x_FLASH
configuration. You should now be at the start of Main().

4154 Debug Environment Windows

It is standard debug practice to watch local and global variables while debugging code. There are various
methods for doing this in Code Composer Studio, such as memory views and watch views. Additionally,
Code Composer Studio has the ability to make time (and frequency) domain plots. This allows the user to
view waveforms using graph windows.

1. If a watch view did not open when the debug environment was launched, open a new watch view and
add various parameters to it by following the procedure given below.

2. Click: View -> Watch on the menu bar.

3. Click the “Watch (1)" tab. You may add any variables to the watch view.

4. In the empty box in the "Name" column, type the symbol name of the variable you want to watch and
press enter on keyboard. Be sure to modify the “Format” as needed. The watch view should look
something like Figure 22. Please note that some of the variables have not been initialized at this point
in the main code and may contain some garbage values. FaultFlg, if set, indicates an over current
condition (discussed above), which shuts down the PWM outputs. PWM outputs are held in this state
until a device reset (follow the proper procedure in Step 11 of Section 4.1.5.6). The lpri_trip variable
sets the internal 10-bit DAC reference level for the on-chip comparator 2. Please note that this is a
Q15 number.

% | & @ |3

Value Address Type Farmat

(9= Gui_YFbout 2.59453 0x00008335@0ata  ink Q-Yalue(10)

()= Gui_IfbSet 0.149302 0000053 1E@Data  int G-Yalue{12)

(4= Gui_Ifb -3.33398 Ox00008330@0aka  ink C-Yalue{12)

()= Gui_lout -235.469 Ox00005332@0aka  ink Q-Yalus(7)
)= Slope 40 0x0000833C@Data int Matural
(9= dbatkaP_leq 20 0:0000533B@0ata int Tatural
()= dbPtos_leg 20 0x00005339@0ata  int Tatural
()= auto_DE 1 0x00005310@0ata  int Tatural
()= SR_mode s 0x00005312@0ata  int Matural

()= Gui_Pout 0.0 0x00005321@0ata  int Q-Value()
(9= FaultFlg -30140 Ox0000533A@0ata int Tatural
(9= Iref i} 0x0000535C@0ata long Tatural

= Gui_vfbin -G46.656 0x00005331@0ata  ink -Walue(S)

ZMEw
Figure 22.
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4155

Using Real-Time Emulation

Real-time emulation is a special emulation feature that allows the windows within Code Composer Studio
to be updated at up to a 10 Hz rate while the MCU is running. This not only allows graphs and watch
views to update, but also allows the user to change values in watch or memory windows, and have those
changes affect the MCU behavior. This is very useful when tuning control law parameters on-the-fly, for
example.

1.

Enable real-time mode by hovering your mouse on the buttons on the horizontal toolbar and clicking

J‘% Enable Silicon Real-time Mode (service critical interrupts when halted, allow
debugger accesses while running) button

. A message box may appear. If so, select YES to enable debug events. This will set bit 1 (DGBM bit) of

status register 1 (ST1) to a “0”. The DGBM is the debug enable mask bit. When the DGBM bit is set to
“0”, memory and register values can be passed to the host processor for updating the debugger
windows.

. ! H . .
Now click ¥ Enable Polite Real-time Mode button on the same horizontal toolbar.

When a large number of windows are open, as bandwidth over the emulation link is limited, updating
too many windows and variables in continuous refresh can cause the refresh frequency to bog down.

Right click on the " button in the watch view and select “Customize Continuous Refresh Interval..”.
You can slow down the refresh rate for the watch view variables by changing the Continuous refresh
interval (milliseconds) value. A rate of 4000 ms is usually enough for these exercises.

=t
Click on Continuous Refresh buttons =~ for the watch view.

5.
4.1.5.6 Run the Code

1. Run the code by using the <F8> key, or using the Run button on the toolbar, or using Target -> Run on
the menu bar.

2. In the watch view, the variable Gui_IfbSet should be set to 0.15 (Q12). This variable denotes the peak
current reference command in Amperes and drives Iref to the DACDRV_RAMP module. Do not use a
value of less than 0.15 for Gui_IfbSet.

3. Apply an appropriate resistive load to the PSFB system at the DC output. A load that draws around
3A — 6A current at 12V output is a good starting point.

NOTE: For safety reasons it is recommended to use an isolated DC source to supply 400V DC input
to the board.

4. Power the input at J1, J2 with 400V DC.

5. Increase the peak current reference command by setting Gui_IfbSet to a higher value 0.25(say) in the
watch view. The output voltage should increase. Observe the output voltage carefully, this should not
be allowed to exceed the capabilities of the board. Keep in mind that when operating with a certain
Gui_IfbSet value if the load is suddenly reduced, the output voltage will go up. Therefore do not make
any sudden changes of load or big increases in Gui_IfbSet command when operating in build 1.

6. Observe the different ADC results in the watch view for different Gui_IfbSet values.
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7. Here is the watch view that corresponds to the operation of the system with a Gui_IfbSet command of
1.17A with an input voltage of around 400V and a load of around 6A at 12V output.

SUERRENE S iatch (2)

% |EE 77

Mame
(D= Gui_vfhouk
(b= Gui_IfbSet
(9= Gui_Ifb
(h= Gui_Touk
()= Slope
(= dbatoP _leg
()= dbPod,_leg
()= auto_DB
()= SR_maode
(D= Gui_Pout
(%)= FaultFlg
()= Tref
(b= Gui_MFbin
<MEW =

Address
00005335 @0ata
000005331 E@Data
0.175537 Ox00005330@0ata
6.20313 Ox00003332@Data
40 Q0000533 @0 ata
32 Q00005 336@0ata
42 Ox000053339@Data
1 00000533 10@0ata
2 0x0000531 2@Data
5.0 000003321 @Data
1] O=000053338@0 aka
2596614 Ox00005335 @0 aka
399,25 0000053331 @Data

Value
12,0654
1.16992

Type
int
ink
int
ink
int
int
ink
int
int
ink
int
long
inl

Format
Q-Yalued10)
Q-Yaluel12)
Q-Yaluel12)
Q-WalueTy
Patural
Matural
Matural
Matural
Matural
Q-Yalueld
Matural
Matural
Q-YaluelSh

Figure 23.

8. The following oscilloscope capture shows transformer primary voltage, primary sensed current and
PWM waveforms driving two diagonally opposite switches (Q1 and Q3) seen under conditions

described above.

Figure 24.

GS’/’S" =
points
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9. By default the synchronous rectifiers are operated in mode 2. You may change their mode of
operation by changing SR_mode variable to 0, 1 or 2 from the watch view. Observe the change in
amount of input current being drawn and change in output voltage with different SR modes. You may
also probe the PWM waveforms driving the synchronous rectifier switches. Do not change between
different SR modes when operating at very low loads or when the output voltage is very low (less than
6V). In these cases use the default SR mode 2.

10. Try different Gui_IfbSet values and observe the corresponding ADC results. Increase Gui_IlfbSet in
small steps. Always observe the output voltage carefully, this should not be allowed to exceed the
capabilities of the board. Different waveforms, like the PWM gate drive signals, input voltage and
current and output voltage may also be probed using an oscilloscope. Appropriate safety precautions
should be taken and appropriate grounding requirements should be considered while probing these
high voltages and high currents for this isolated DC-DC converter.

11. Fully halting the MCU when in real-time mode is a two-step process. With the 400V DC input turned
off wait a few seconds. First, halt the processor by using the Halt button on the toolbar, or by using

Target -> Halt. Then click s button again to take the MCU out of real-time mode and then reset the

MCU.
12. You may choose to leave Code Composer Studio running for the next exercise or optionally close

CCs.
13. End of Exercise
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4.2 Build 2: Full HVPSFB
421 Objective
The objective of this build is to verify the operation of the complete PCMC based HVPSFB project from
the CCS environment.
4.2.2 Overview

Figure 25 shows the software blocks used in this build. A two pole two zero controller is used for the
voltage loop. Depending on the application’s control loop requirements some other controller block like a
Pl, a 3-pole 3-zero, etc may also be used. As seen in Figure 25, the voltage loop block is executed at 100
KHz. CNTL2P2Z is a 2nd order compensator realized from an IIR filter structure. This function is
independent of any peripherals and therefore does not require a CNF function call.

200Khz
R ePWM1A
100Kh 100Khz e  Timing lCrmcgl Tasks > —>
Z — Reconfigurations for next ISR
CNTL_2P2Z:1: DACDRVARAME 1 PWM1B
> e | DG :
(—{Tref 0 DACDRV_RAMP_In:n: 10-bit + P ePWM2A
ma BTN g
Comp M
ePWM2B
H
w ePWM4A
—>
- Dmin dbAtoP — ePWM4B
E Dmax 100Khz >
2 100Khz [ ADCDRV_4ch:1,4,6.8: dbPtoA —
2
< RItPtrA |€— ADC A0
100Khz
- RItPtrB A [€— ADC AO [ ADCDRV_Ich:2:
=
2 RIPHC e €« ADC A0 _<—+_A"°—Ifb 0 ADCDRV_1ch_Rlt ‘ ADC (€— ADC A
f=2}
g
s RItPtrD |€— ADC A0 100Khz
Z [ ADCDRV_Ich:3:
=
= 100Khz ADCDRVJcth]t ‘ ADC «— ADCB
§ ADCDRV_4ch:1,4,6,8:
] RItPErA 100Khz
3 €— ADC A0 [ ADCDRV_Ich:9:
[<b)
5 RItPtrB A [€— ADC A0 ADCDRVJch,RIt ‘ ADC <«— ADCB
E b
RItPtrC C €— ADC A0
RItPED €— ADC A0

Figure 25. Build 2 Software Block

The five coefficients to be modified are stored as elements of the structure CNTL_2P2Z CoefStructl
whose other elements are used for clamping the controller output. The CNTL_2P2Z block can be
instantiated multiple times if the system needs multiple loops. Each instance can have separate set of
coefficients. Directly manipulating the five coefficients independently by trial and error is almost
impossible, and requires mathematical analysis and/or assistance from tools such as matlab, mathcad,
etc. These tools offer bode plot, root-locus and other features for determining phase margin, gain margin,
etc.

To keep loop tuning simple and without the need for complex mathematics or analysis tools, the
coefficient selection problem has been reduced from five degrees of freedom to three, by conveniently
mapping the more intuitive coefficient gains of P, | and D to BO, B1, B2, Al, and A2. This allows P, | and
D to be adjusted independently and gradually. These mapping equations are given below.
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The compensator block (CNTL_2P2Z) has 2 poles and 2 zeros and is based on the general IIR filter
structure. It has a reference input and a feedback input. For the voltage loop the feedback is the average
output voltage calculated over one PWM cycle (Avg_Vout), while the reference input to the controller is a
slewed version (VfbSetSlewed) of the output voltage reference command (Vref). The transfer function is

given by:
U(Z) _ bo+biz"' + bz’
E(Z) l+aiz” + a2z (1)

The recursive form of the PID controller is given by the difference equation:
u(k) =u(k =1) +boe(k ) + bre(k 1)+ bae(k - 2)
where
bo=Kp+ Ki+ Ka
b =-K,+Ki—2Ka
b2 = Ku
And the z-domain transfer function form of this is:
Uz by biz' biz® boz" bz b

E z 1 Z1 22 z (3)

Comparing this with the general form, we can see that PID is nothing but a special case of CNTL_2P2Z
control where:

ar=-1 and a2=0 )

For the voltage loop these P, | and D coefficients are: Pgain, Igain and Dgain. These P, | and D
coefficients are used in Q26 format. To simplify tuning from the GUI environment (or from CCS watch
views) these three coefficients are further scaled to values from 0 to 999 (Pgain_Gui, lgain_Gui and
Dgain_Gui).

From the GUI environment the voltage loop can also be tuned using two poles (fpl, fp2), two zeroes (fz1,
fz2) and gain (Kdc). These parameters provide b2_Gui, bl_Gui, bO_Gui, a2_Gui and al_Gui coefficients
in 15Q10 form which are then converted to the five Q26 coefficients for the 2P2Z controller. Although not
recommended, b2_Gui, bl _Gui, b0_Gui, a2_Gui and al_Gui values may also be directly changed from
the CCS environment using watch views. Please refer to HVYPSFB-Calculations.xls file for details on these
calculations. The equations for deriving coefficient values based on poles, zeroes, gain and switching
frequency are also clear from the GUI source file.

This project allows easy evaluation of both methods of loop tuning by providing the ability to easily switch
between coefficients during execution. This can be done by simply clicking on the 2P2Z(On)/PID(Off)
button on the GUI or changing the pid2p2z_GUI variable to 0 or 1 on the watch view from CCS. PID
based loop tuning (pid2p2z_GUI = 0) from the GUI environment was used as a starting point. Poles,
zeroes and gain corresponding to these PID tuned coefficients were then used as a starting point for
further loop tuning based on the second method (pid2p2z_GUI = 1). Much better results were then
achieved by changing poles, zeroes and gain from the GUI environment to tune for optimum dynamic
performance. By default coefficients based on these tuned poles, zeroes and gain values (pid2p2z_GUI =
1 — default) are used.

NOTE: When tuning the system using the 2-pole 2-zero controller coefficient adjustments, if a
choice of poles, zeroes and Kdc values is made in the GUI such that it result in the
magnitude of any of the coefficients (b2, b1, b0, a2, al) to be greater than or equal to 32,
then these coefficient values are not sent to the controller by the GUI.
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4.2.3

Constant Current (CC) and Constant Power (CP)

Simple implementation for experimenting with constant current and constant power functionality has been
included in this project. By default this functionality is disabled. Constant current function is implemented
by changing the clamping value of the voltage loop controller. Constant power function is implemented by
adjusting the voltage loop reference command based on load to maintain constant power at the output.

Following provides the complete software flowchart for these functions.

Following routine

executed if start_flag = 1

Dmax < Max
Dmax?

Dmax = Max | tD
Dmax ncrement Dmax

CC _flag=0
CP_flag =0

lout > CC_MIN? &
CC_Enable = 1?

Note: Max Dmax = maximum Dmax
value under normal operation i.e.
when system is not in CC/CP mode.

<

Decrement Dmax
slower

[ CC Routine:
[ CP Routine

Decrement Dmax
faster

CC_flag=1
CP_flag=0

No

Pout > Yes

No Yes

Increment Gui_VfbSet, such

that we operate in CP mode

when lout is > lout threshold
& CC mode is not active

CP_flag=0

CP_MIN?

Pout >
CP_MID?

Decrement
Gui_VfbSet faster

Decrement
Gui_VfbSet slower

|l —

No

CP_flag=1

Yes

CP_flag =0

Figure 26. Constant Current and Constant Power Software Flowchart
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42.4

4241

Procedure

Build and Load Project

To quickly execute this build using the pre-configured work environment, follow the following steps:

1.

4242

Follow Steps 1 to 2 exactly as in build 1. If you were working on build 1 the last time CCS was used,
the same workspace should open up with the project. If this is not the case, you can open the
workspace used for build1 by clicking File -> Switch Workspace and then navigating to the correct
workspace. If a workspace was not saved or got deleted, please follow steps 3 and 4 exactly as in
build1.

Locate and inspect the initialization code specific to build 2 in the main file. This is where all the control
blocks are configured, initialized and connected in the control flow.

Select the Incremental build option as 2 in the HYPSFB-Settings.h.

NOTE: Whenever you change the incremental build option in HVPSFB-Settings.h always do a
“Rebuild All".

Click Project -> “Rebuild All” button and watch the tools run in the build window.

Click Target -> "Debug Active Project”. The program will be loaded into the FLASH or RAM memory
depending on the project configuration. This project comes in only F2802x_FLASH configuration. You
should now be at the start of Main().

Debug Environment Windows

It is standard debug practice to watch local and global variables while debugging code. There are various
methods for doing this in Code Composer Studio, such as memory views and watch views. Additionally,
Code Composer Studio has the ability to make time (and frequency) domain plots. This allows us to view
waveforms using graph windows.

1.

If a watch view did not open when the debug environment was launched, open a new watch view and
add various parameters to it by following the procedure given below.

Click: View -> Watch on the menu bar.
Click the “Watch (1)" tab.

If a watch view is already open from the debug environment saved for build 1, click on button in the
watch view. A “Watch (2)” tab will open and you may then drag it to be viewed in a window of your
choice. You may add any variables to this watch view tab.

TIDU248—-May 2014 Phase-Shifted Full Bridge DC/DC Power Converter Design Guide 33
Submit Documentation Feedback

Copyright © 2014, Texas Instruments Incorporated


http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDU248

13 TEXAS

INSTRUMENTS
Procedure for running the incremental builds - PCMC www.ti.com

5. In the empty box in the "Name" column, type the symbol name of the variable you want to watch and
press enter on keyboard. Be sure to modify the “Format” as needed. The watch view should look
something like Figure 27. Please note that some of the variables have not been initialized at this point
in the main code and may contain some garbage values.

Watch (23 X =

Walue Address ... | Format
= Gui_WFb3et 12,1992 000008320 0ata i Q-Yalued 100
= Gui_WFbout 12,1953 00000533+ @0aka i C-Yalued 100
= Gui_YFbin 395,781 Ox00008332@0ata i Q-Yaluels)
= Gui_Touk 6.14544 000008321 @0aka i Q-Value(7)
= Gui_Ifb 0168457 00008331 @0ata i Q-Value(12)
= Slope 40 00000831 2@0ata i Matural
= dbAtoP_leg 32 00000533 M@0atka i Makural
= dbPtod_leg 42 00000831 3@0ata i Makural
= guto_DE 1 (0000831 9@Data i Matural
= SR_rmiode 2 0x0000831 M@0 ata i Matural
= CiC_Enahble 0 O:x00008300@0aka i Tatural
= CP_Enable 1] O=00008303@0ata i Tatural
= Gui_Pout 74,9544 Ox00005322@0ata i C-Yaluels)
= CC_flag 0 Ox0000E305@0ata i Matural
= CP_flag 000008304 @0aka i Matural
= | _Shutdown 000008301 @Data i Matural
= FaultFlg 0x00008337@0ata i Matural
= Auko_Run 0x00008305@0ata ink Makural

I A
Figure 27.
Notice the additional variables in the watch window.
6. Gui_VfbSet is used to set the output voltage command.
4.2.4.3 Run the Code

1. Follow steps 1 to 4 of the build 1 procedure to enable real-time mode and continuous refresh for the
watch views and also for changing the continuous refresh interval for the watch view if needed.

2. Run the code by using the <F8> key,or using the Run button on the toolbar, or using Target -> Run on
the menu bar.

3. Apply an appropriate resistive load to the PSFB system at the DC output. A load that draws around
3A — 6A current at 12V output is a good starting point.

NOTE: For user safety, it is recommended to use an isolated DC source to supply 400V DC input to
the board.

4. Power the input at J1, J2 with 400V DC.

5. By default Auto_Run is set to 1. If it is not make it 1 from the watch view. The output voltage should
now start ramping up to 12V. This output voltage ramp up rate can be changed by changing the
variable VfbSlewRate.

6. Here is the watch view that corresponds to the operation of the system with 12.2V at the output with an
input voltage of around 400V and a load of around 6A output.
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= Gui_WFbSet
D= Gui_WFbout
6= Gui_YFhin
= Gui_Tout
6= Gui_Ifb
= Slope

4= dbatoP_leq
(9= dbPtoA_leg
()= auto_DE
9= SR _mode
()= CC_Enable
()= CP_Enable
(D= Gui_Pout
= CC_flag
)= CP_flag

)= U _Shutdown

(= FaulFlg
9= Auto_Run

%

R

=

L

-

-

Walue
12,1992
12,1953
395,781
6.14844
0.168457
40
32

Address
000008320 0atka
000008334 @0atka
Ox00005332@0ata
000008321 @0ata
000008331 @0Data
00000831 2@Data
00005 338@0ata
00000831 3@0ata
00000531 2@Data
00000531 Alrata
0:00008300@Crata
O=00005303@0ata
O=00008322@0atka
Ox00005305@Cata
000008304 @Crata
000005301 @0ata
000008337 @0Data
00005 305@0ata

Figure 28.
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7. The following oscilloscope capture shows the transformer primary voltage, the primary sensed current

and PWM waveforms driving two diagonally opposite switches (Q1 and Q3) seen under conditions
described above. ZVS switching of switch Q3 and LVS switching of switch Q4 are also shown under

these conditions.

Figure 29.
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Figure 31.

8. By default the synchronous rectifiers are operated in mode 2. You may change their mode of operation
by changing SR_mode variable to 0, 1 or 2 from the watch view. Observe the change in amount of
input current being drawn and change in output voltage with different SR modes. You may also probe
the PWM waveforms driving the synchronous rectifier switches. Do not change between different SR
modes when operating at very low loads (below 3A). In these cases use the default SR mode 2.

9. Observe the effect of varying the load* on the output voltage and input current. There should be
virtually no effect on the output voltage. Similarly observe the effect of varying the input voltage*. Again
there should be virtually no effect on the output voltage.

NOTE: Ensure these changes are made within the abilities of the board, as listed in Section 1.3 of
this document.

10. Different waveforms, like the PWM gate drive signals, input voltage and current and output voltage
may also be probed using an oscilloscope. Appropriate safety precautions should be taken and
appropriate grounding requirements should be considered while probing these high voltages and high
currents for this isolated DC-DC converter.

11. Simple ‘Constant Current (CC)’ and ‘Constant Power (CP)’ functions are also implemented in this
project and can be experimented with by enabling/disabling their corresponding flags (CC_Enable and
CP_Enable).

12. Fully halting the MCU when in real-time mode is a two-step process. With the 400V DC input turned
off wait a few seconds. First, halt the processor by using the Halt button on the toolbar, or by using
Target -> Halt. Then click button again to take the MCU out of real-time mode and then reset the MCU.

13. Close CCS.
14. End of Exercise
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5 Software Overview — VMC

5.1 Software Control Flow

The HVPSFB_VMC project makes use of the “C-background/ASM-ISR” framework. It uses C-code as the
main supporting program for the application, and is responsible for all system management tasks, decision
making, intelligence, and host interaction. The assembly code is strictly limited to the ISR (Interrupt
Service Routine), which runs all the critical control code and typically this includes ADC reading, control
calculations, and PWM and DAC updates. Figure 32 depicts the general software flow for this project.

C Environment Assembly
R Tk

Initialisation Context Save
28x Device level
Peripheral lavel

Systern lewel

ISR, ADC

‘ CMTL_2P2Z (if closed loop) ‘

v

‘ PYRADRY (WM C with SR) ‘

‘ ‘Elackground Loop ‘ ‘

DATALOG

‘ |ElackgroundLnnp‘ ‘

: : : TerT]
Timer 1 Tasks: Timer 2 Tasks: Timer 3 Tasks:
= Communications - Instrurne ntation = Soft-start/shut-dawn
= Yloop Slew limit = Auto DB adjust

= 2P27 coeff cale

Figure 32. VMC Software Flow

The key framework C files used in this project are:

HVPSFB-Main.c — This file is used to initialize, run, and manage the application. This is the “brains”
behind the application.

HVPSFB-DevInit.c — This file is responsible for a one time initialization and configuration of the F280x
device, and includes functions such as setting up the clocks, PLL, GPIO, etc.

The ISR consists of a single file:

HVPSFB-DPL-ISR.asm — This file contains all time critical “control type” code. This file has an initialization
section (one time execute) and a run-time section which executes (typically) at the same rate as the PWM
timebase used to trigger it.

The Power Library functions (modules) are “called” from this framework.

Library modules may have both a C and an assembly component. In this project, following library modules
are used. The C and corresponding assembly module names are:
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Table 5. Library Modules

C Configure Function ASM Initialization Macro ASM Run-Time Macro
PWMDRSVR—P(:Sl\'I:FB—VMC— PWMDRV_PSFB_VMC_SR_INIT n,m,p PWMDRV_PSFB_VMC_SR n,m,p
ADC_SOC_Cnf.c ADCDRV_4CH_INIT m,n,p,q ADCDRV_4CH m,n,p,q
CNTL_2P2Z_INIT n CNTL_2P2Z n

The control blocks can also be represented graphically as shown in Figure 33

PWMDRV_PSFB_VMC_SR 1,2,4
ePWM1A
CNTL_2P2Z:1: 1
PWM1B
Out g—{ phase | [phase —3»ci PWMDRV_PSFB_Phase:n:
G ra S Pl oPwM2A
DBUFF ‘I:Ilv —
—» 0 Coef
ePWM2B
CNTL_2P27_CoefStruct
BO H
Bl
w
B2 PWMDRV_PSFB_DbAtoP:n: ._§PWM4A
A2
Dmin
PWM4B
Dmax GPWMDRV_PSFB_DbPtoA:n: S
ADCDRV_4ch:1,2,3,4:
Adc_Vfbout RItPtrA ADC A0
Adc_lfb RItPrB A l€— ADC A2
D
Adc_Vfbin RItPtrC C «— ADCB1
Adc_lout RItPtrD i¢«— ADC B4

Figure 33. VMC Software Blocks

Notice the color coding for modules in Figure 33. Blocks in ‘dark blue’ represent hardware modules on the
C2000 micro-controller. Blocks in ‘blue’ are the software drivers for these modules. Blocks in ‘orange’ are
the controller blocks for the control loop. Although a 2-pole 2-zero controller is used here, the controller
could very well be a PI/PID, a 3-pole 3-zero or any other controller that can be suitably implemented for
this application. Such a modular library structure makes it convenient to visualize and understand the
complete system software flow as shown in Figure 34. It also allows for easy use and additions/deletions

of various functionalities.

This fact is amply demonstrated in this project by implementing an incremental build approach. This is

discussed in more detail in Section 5.2.
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100Khz
PWMDRV PSFB VMC SR 1,2,4
ePWM1A
100Khz
CNTL_2P2Z:1: PWM1 B
- —
,—{ phase >0 PWMDRV_PSFB_Phase:n: P SPWM2A
Wi
M epwmzs
H
PWMDRV_PSFB_DbAtoP:n: L <_EPWM4A
oPWMDRV_PSFB_DbPtoA:n: _e>PWM4B
100Khz
ADCDRV 4ch:1,2,3,4:
€ Adc_Vfbout RItPtrA €— ADC A0
Adc_lfb RItPtrB A [€— ADCA2
D
Adc_Vfbin RItPtrC C «— ADCB1
Adc_lout RItPtrD «¢— ADC B4

Figure 34. VMC Control Flow

The system is controlled by one voltage feedback loop. Figure 34 also gives the rate at which control
blocks are executed. For example, the voltage controller is executed at a rate of 100 kHz (same as the
PWM switching frequency). Following explains the control implemented above.

The sensed output voltage (Adc_Vfbout) is compared with slewed version (VfbSetSlewed) of the voltage
reference command (Vref) in the voltage controller. The voltage controller output directly controls phase
shift between PWM signals driving the two legs of the full bridge. This dictates the amount of phase
overlap between the two legs of the full bridge to regulate the output voltage. The dbAtoP_leg and
dbPtoA leg values provide dead band values for the ‘Active to Passive’ and ‘Passive to Active’ legs of the
full bridge, respectively. These are used to achieve ZVS/LVS across the load range.

5.2 Incremental Builds

This project is divided into two incremental builds. This makes it easier to learn and get familiar with the
board and the software. This approach is also good for debugging/testing boards. The build options are
shown below. To select a particular build option, set the macro INCR_BUILD, found in the HVPSFB-
Settings.h file, to the corresponding build selection as shown below. Once the build option is selected,
compile the complete project by selecting rebuild-all compiler option. Next chapter provides more details to
run each of the build options.

Table 6. Incremental Build Options for VMC

Open loop PSFB drive with ADC feedback (Check PWM drive
circuit and sensing circuit)

INCR_BUILD =2 Closed voltage loop (Full PSFB in VMC mode)

INCR_BUILD =1
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6

6.1

6.1.1

6.1.2

Procedure for Running Incremental Builds

The main source files, ISR assembly file and the project file for C framework to bring up the PSFB system
are located in the following directory (please use the latest version of the software package. Version 1.1 is
the latest software version as of March

2012) ..\controlSUITE\development_kits\HVPSFB_v1.1\HVPSFB_VMC. The projects included with this
software are targeted for CCSv4.

Follow the steps below to build and run the example included in the HVPSFB_VMC software.
Build 1: Open-Loop Check with ADC Feedback

Objective

The objective of this build is to evaluate the open loop operation of the system, verify the PWM and ADC
driver modules, verify the MOSFET driver circuit and sensing circuit on the board and become familiar
with the operation of Code Composer Studio (CCS). Since this system is running open-loop, the ADC
measured values are only used for instrumentation purposes in this build. Steps required to build and run
a project will be explored.

Overview

The software in Build1l has been configured so that the user can quickly evaluate the phase shifted full
bridge PWM driver module by viewing the output waveforms on an oscilloscope and observing the effect
of change in phase on the output voltage by interactively adjusting the phase on CCS. Additionally, the
user can evaluate the ADC driver module by viewing the ADC sampled data in the watch view.

The PWM and ADC driver macro instantiations are executed inside the DPL_ISR as mentioned in the
previous chapter. Figure 35 shows the blocks used in this build. ePWM1A and ePWM1B drive Q2 and Q3
full-bridge switches, while ePWM2A and ePWM2B drive Q1 and Q4 full-bridge switches. ePWM4A and
ePWM4B drive Q6 and Q5 synchronous rectifier switches.

100Khz
PWMDRV_PSFB_VMC_SR 1,2,4

ePWM1A
>

gPW\M'l B

PWMDRV_PSFB_Phase:n:
[phase [—>1 PsFB.] ePWM2A

ePWM2B
—>

sT =s7

PWMDRV._PSFB_DbAtoP:n: | SPWM4A

SPWMDRV_PSFB_DbPtoAn SPWM4B

!

100Khz
ADCDRV_4ch:1,2,3,4:

Adc_Vfbout RItPtrA ADC A0

Adc_lfb RItPtrB €— ADC A2

ng»>

Adc_Vfbin RItPtrC €«— ADCB1

Adc_lout RItPtrD «— ADC B4

Figure 35. Build 1 Software Blocks
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6.1.3

These PWM signals need to be generated at a frequency of 100 kHz i.e. a period of 10 us. With the MCU
operating at 60 MHz, one count of the time base counter of ePWM1, ePWM2 or ePWM4 corresponds to
16.667ns. This implies that a PWM period of 10 us will be equivalent to 600 counts of the time base
counter (TBCNT1, TBCNT2 and TBCNT4). The ePWM1 and ePWM2 modules are configured to operate
in up-count mode, while ePWM4 operates in up-down count mode. ePWM1A and ePWM1B outputs
operate at 50% duty cycle and are complementary to each other. Similarly ePWM2A and ePWM2B
operate at 50% duty cycles and are complementary to each other. Phase for ePWM2 time base may be
changed dynamically with respect to ePWM1 phase. These PWM waveforms are shown in Figure 16.

The phase input to the PWM driver module decides the amount of phase shift between PWM1 and PWM2
time bases. This phase value controls the amount of overlap between PWM signals driving diagonally
opposite switch pairs of the full bridge. As phase increases, amount of overlap increases, which increases
the amount of energy transferred to the secondary. The TBPHS2 value is derived from the input “phase”
command.

Table 7 gives example TBPHS2 values derived for a TBPRD value of 599.

Table 7. Phase Values for Reference

Phase (Q24) TBPHS2 = (phase*TBPRD/2/25) Phase Shift in Degrees
2097152d 37 225
8388608d 149 90
16776704d 299 180

Note that each pair of diagonal switches of the full bridge overlaps once in one PWM period. This means
the most overlap will occur when the phase shift is close to 180 degrees.

The assembly ISR is triggered on a ZRO (TBCNT1 = 0) event of ePWML. This is where the control driver
macros are executed and the TBPHS2 and TBPHS4 registers updated.

There is an important consideration regarding where the ADC input is sampled. The integrity of the ADC
input signals is of high importance since this is where signals from the analog and digital domains
interface. Turning a switch ON/OFF in the power stage may result in some noise or disturbance on the
signals that are to be sensed around this point in time. Even with all the filtering provided on these signals
to avoid this noise from showing up at the ADC inputs, it is prudent to sample the ADC inputs at a time
such that this disturbance is avoided.

Moreover, as discussed in Section 2.5, sensed output voltage should preferably be sampled at an
appropriate point in the switching cycle where the output voltage value is close to its average value. To
achieve this, the ADC input signals are sampled at a time so as to get as noise free a sample as possible
and to also sample the average output voltage. For the full bridge this is achieved by sampling at the
midpoint of the overlap between two diagonal switches (here overlap refers to the period when both
switches are ON at the same time) i.e. as far away from the MOSFET switching as possible. This avoids
any switching noise to be reflected on the ADC result. The flexibility of ADC and PWM modules on C2000
devices allow such precise and flexible triggering of ADC conversions. The ADC driver modules are used
to read 12-bit ADC results and convert them to Q24 values. In every PWM cycle PWM2 SOCA (start of
conversion A) is used to trigger five ADC conversions.

Protection

At this stage, it is appropriate to introduce the shutdown mechanism used with this project. Here
overcurrent protection is implemented for the transformer primary current using on-chip analog comparator
1. The reference trip level is set using the internal 10-bit DAC and fed to the inverting terminal of this
comparator. The comparator outputs are configured to generate a one-shot trip action on ePWM1 and
ePWM2 whenever the sensed current is greater than the set limit. The flexibility of the trip mechanism on
C2000 devices provides the possibilities for taking different actions on different trip events. In this project
ePWM1A, ePWM1B, ePWM2A, and ePWM2B outputs are driven low immediately to protect the power
stage. These outputs are held in this state until a device reset is executed. Please refer to HVPSFB-
Calculations.xls file for details on these calculations.

Input under voltage and over voltage lockout is also implemented in the software.
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6.14 Resource Mapping
The key signal connections between the C2000 micro-controller and the HVPSFB stage are summarized
in Table 8. Note that PWM mapping is different between VMC and PCMC projects. Jumper (J2, J3 —
PCMC and VMC PWM drive jumper enables) on the controller card need to be correctly configured for
VMC mode (Default jumper positions are set for PCMC operation). Here are the jumper configurations for
the two modes:
PCMC: J2(1) -> J3(1), J2(2) -> J3(2), J2(3) -> J3(3), J2(4) -> J3(4), J2(7) -> J3(7), J2(8) -> J3(8),
VMC: J2(1) -> J3(3), J2(2) -> J3(4), J2(3) -> J3(1), J2(4) -> J3(2), J2(7) -> J3(8), J2(8) -> I3(7)
Table 8. HVPSFB Signal Interface Reference —-VMC
; _ Connection to C2000
Signal Name Description Controller
ePWM-1A PWM driver for full-bridge switch Q2 GPIO-00
ePWM-1B PWM drive for full-bridge switch Q3 GPIO-01
ePWM-2A PWM drive for full-bridge switch Q1 GPIO-02
ePWM-2B PWM drive for full-bridge switch Q4 GPIO-03
ePWM-4A PWM drive for synchronous rectifier switch Q6 GPIO-06
ePWM-4B PWM drive for synchronous rectifier switch Q5 GPIO-07
Vout PSFB output voltage ADC-AO0
Ifb Transformer primary current ADC-A2/COMP1A
Ifb Transformer primary current ADC-A4/COMP2A®
Vibin PSFB input voltage ADC-B1
loutl PSFB output current ADC-B3
lout2 PSFB output current (heavily filtered) ADC-B4
@ Default jumper J4 configuration on controller card. Input is configurable by jumper J4 selection.
NOTE: The HVPSFB_PCMC and HVPSFB_VMC projects use DSP2802x_Comp.h and
DSP2802x_EPWM.h header files that are located in their own project directories instead of
the ones located in the device_support directory. The two files in device_support directory
will be updated at a later update of ControlSuite, at which time these updated files may be
used with the two projects.
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6.14.1

6.1.4.11

Procedure

Start CCS and Open a Project

To quickly execute this build, follow the following steps:

1.
2,

4,

Make sure that jumper J6 on the base board is not populated, while jumper J8 is populated.

By default, resistor R6 on Piccolo Macro of the controller card and jumper J1 are removed to enable —
boot from FLASH. Re-populate these two to run and program RAM or program FLASH. Connect USB
connector to the Piccolo controller card for emulation. Use of an appropriate isolated DC power supply
set to output around 400V DC is recommended. DC power supply needs to remain off before it is
connected to J1 and J2 on the main board. Use a 20AWG 600V wire to connect the Power Source to
J1 and J2. Make sure that the polarity of this connection is correct. Apply an appropriate resistive/DC
electronic load to the phase shifted full bridge system at the DC output at J3 and J4. Do not turn on
400V DC power at this time. Power up the bias supply between TP1 and TP2 with around 11V DC
(this voltage must be less than 12V).

Double click on the Code Composer Studio icon on the desktop. Maximize Code Composer Studio to
fill your screen. Close the welcome screen if it opens up.

A project contains all the files and build options needed to develop an executable output file (.out)
which can be run on the MCU hardware. On the menu bar click: Project -> Import Existing CCS/CCE
Eclipse Project and under Select root directory navigate to and

select ..\controlSUITE\development_kits\HVPSFB_v1.1\HVPSFB_VMC directory. Make sure that under
the Projects tab HYPSFB_VMC is checked. Click Finish.

This project will invoke all the necessary tools (compiler, assembler, linker) to build the project.

5. In the project window on the left, click the plus sign (+) to the left of Project. Your project window will
look like the following:

[ %5 vebug | cror+

sS40

o i s
SHYPSFB_YMC
Figure 36.
TIDU248—-May 2014 Phase-Shifted Full Bridge DC/DC Power Converter Design Guide 43

Submit Documentation Feedback

Copyright © 2014, Texas Instruments Incorporated


http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=TIDU248

Procedure for Running Incremental Builds

13 TEXAS
INSTRUMENTS

www.ti.com

6.1.4.1.2

Device Initialization, Main, and ISR Files

NOTE: Do not make any changes to the source files — Only Inspect

1. Open and inspect HVPSFB-DevInit_F2802x.c by double clicking on the filename in the project window.
Notice that system clock, peripheral clock prescale, and peripheral clock enables have been setup.
Next, notice that the shared GPIO pins have been configured.

2. Open and inspect HYPSFB-Main.c. Notice the call made to Devicelnit() function and other variable
initialization. Also notice code for different incremental build options (specifically the build you are going
to compile now), the ISR intialization and the background for(;;) loop.

3. Locate and inspect the following code in the main file under initialization code specific for build 1. This
is where the PWMDRV_PSFB_VMC_SR block is connected and initialized in the control flow.

PWHDRV_FSFE_VMC_ZR_CNF (1, PWM_FRD, 1, 1); /¢ ePWMl and ePWHMZ, Feriod=PWM FRD,
HHSR_Enable=1 (ePWN4) , Cowpl Prot=1

/¢ Connect the FUMDRYV_FSFE_VMC 3R driver block
/¢ Point to the phase net

FPWHDEY_FP3FE Fhasel
FPWHDEV _P3FE_DhitoFl
FPWHDEV _PSFE_DbFtoll

&phase;

£dbicoP_leg:
£dbProd leg:

/¢ Point to the left leg dead band adjust
/¢ Point to the right leg dead band adjust

4. Locate and inspect the following code in the main file under initialization code specific for build 1. This
is where the ADCDRV_4CH block is configured, initialized and connected in the control flow.

#define Vibh outR
#define IfbE
#define Vib_inR
#define IcutR

AdcResult ADCEEIULTL
AdcResult . ADCRESULTE
AdeResult .  ADCRESULTS

AdcResult . ADCEE3ULTS

/¢ Channel Selection for Cascaded Sequencer
A0 - OfF Voltage - Duwmny

a0 - OfP Voltage

b2 - Transformer Primary Current

ChSel[0] =
ChSel[1] =
ChSel[2] =
ChSel[3] =
Choel[4] =

Trigsel[0]
Trigiel[1]
Trigiel[Z]
Trig3el[3]
Trig3el[4]

EALLOCW:

o;:
0;
2
Sl
1z

=1 =1 -1 -1 -]
.

.

..

b

i
i
o
A
i

A
i
i
o
A

i
i
A

L

El - I/P Voltage
B4 - Iouti
4P Woltage

/P Voltage
Transformer
I/F Woltage

sawpling triggered by EPWM:Z S0OCA4 - Dumny
sampling trigogered by EPWM: S0OCL

Primary Current sampling triggered by EPUMZ 30C4
sanpling triggered by EPWMzZ S0OCA

Iout sampling trigogered by EPUMZ S0C4

AdcRegs . 30CPRICTL.bit . 3OCPRIORITY = 4:; // 30C0-3 are high priority

EDIS:;

ADC_Z0C_CNF (Chiel, Trigiel, ACQPE,

/¢ ADC feedhack connections
gdde_Vibout;

ADCDEW_4ch RItFrrld

ADCDEV_#ch R1tPLrB =

ADCDEV_4ch R1tPrrc
ADCDEV_4ch R1tPrrD

&hde Ifl;

16, 0);// ACQPS=8, Mo ADC channel triggers an interrupt IntChSel > 15,
f4 Mode= Start/Stop (0)

&hde Vibhing
&hde Tout;
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5.

6.1.4.1.3
1.

6.1.4.14

Open and inspect HYPSFB-DPL-ISR.asm. Notice the _DPL_Init and _DPL_ISR sections. This is
where the PWM and ADC driver macro instantiation is done for initialization and runtime, respectively.
Optionally, you can close the inspected files.

Buld and Load the Project
Select the Incremental build option as 1 in the HVPSFB-Settings.h file.

NOTE: Whenever you change the incremental build option in HVPSFB-Settings.h always do a
“Rebuild All".

Click Project -> “Rebuild All” button and watch the tools run in the build window.

Click Target -> "Debug Active Project”. CCS will ask you to open a new Target configuration file if one
hasn’t already been selected. If a valid target configuration file has been created for this connection
you may go to Step 5. In the New target Configuration Window type in the name of the .ccxml file for
the target you will be working with (Example: xds100-F28027.ccxml). Check “Use shared location” and
click Finish.

In the .ccxml file that opens up select Connection as “Texas Instruments XDS100v2 USB Emulator”
and under the device, scroll down and select “TMS320F28027". Click Save.

Click Target -> "Debug Active Project”. The program will be loaded into the FLASH or RAM memory
depending on the project configuration selected. This project comes in only F2802x_FLASH
configuration. You should now be at the start of Main().

Debug Environment Windows

It is standard debug practice to watch local and global variables while debugging code. There are various
methods for doing this in Code Composer Studio, such as memory views and watch views. Additionally,
Code Composer Studio has the ability to make time (and frequency) domain plots. This allows the user to
view waveforms using graph windows.

1.

If a watch view did not open when the debug environment was launched, open a new watch view and
add various parameters to it by following the procedure given below. Click: View -> Watch on the menu
bar.

Click the “Watch (1)" tab. You may add any variables to the watch view.

In the empty box in the "Name" column, type the symbol name of the variable you want to watch and
press enter on keyboard. Be sure to modify the “Format” as needed. The watch view should look
something like Figure 37. Please note that some of the variables have not been initialized at this point
in the main code and may contain some garbage values. FaultFlg, if set, indicates an over current
condition (discussed above), which shuts down the PWM outputs. PWM outputs are held in this state
until a device reset (follow proper procedure in Step 11 of Section 6.1.4.1.6). The lpri_trip variable sets
the internal 10-bit DAC reference level for the on-chip comparator 1. Please note that this is a Q15
number.
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6.1.4.15

beh (1 K BRG]

()= phase

()= SR_mode
()= dbAtoP_leg
()= dbPtod_leg
()= auto_DB
()= Gui_Wfbouk
(9= Gui_Ifb

()= Gui_VFhin
()= Gui_Louk
()= GGui_Pout
()= FaultFlg
()= Tpri_trip

0.0

z

20

20

1
-13.3359
-0.015625
-875,375
-223,508
0.0
-13010

Using Real-Time Emulation

Address
0x000053350@0ata
0x000053306@0ata
00000583 16@0ata
000005302 @0ata
0x0000330E@Data
Ox000058326@0ata
Ox00005324@0ata
Ox00005322@0ata
0x=00005325@0Data
000005322 @0ata
0x000053325@0ata
0x000053305@0ata

Figure 37.

ink

Farmak
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Matural
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Q-Value(10)
Q-Value(12)
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Q-Yalue(7)
C-Yalueld)
Matural
Matural

Real-time emulation is a special emulation feature that allows the windows within Code Composer Studio
to be updated at up to a 10 Hz rate while the MCU is running. This not only allows graphs and watch
views to update, but also allows the user to change values in watch or memory windows, and have those
changes affect the MCU behavior. This is very useful when tuning control law parameters on-the-fly, for

example.

1. Enable real-time mode by hovering your mouse on the buttons on the horizontal toolbar and clicking

d‘f} Enable Silicon Real-time Mode {service critical interrupts when halted, allow
debugger accesses while running)

button.

2. A message box may appear. If so, select YES to enable debug events. This will set bit 1 (DGBM bit) of
status register 1 (ST1) to a “0”. The DGBM is the debug enable mask bit. When the DGBM bit is set to
“0”, memory and register values can be passed to the host processor for updating the debugger

windows.

. ! H . )
3. Now click ¥ Enable Polite Real-time Mode  button on the same horizontal toolbar.

4. When a large number of windows are open, as bandwidth over the emulation link is limited, updating
too many windows and variables in continuous refresh can cause the refresh frequency to bog down.
Right click on the button in the watch view and select “Customize Continuous Refresh Interval..”. You
can slow down the refresh rate for the watch view variables by changing the Continuous refresh
interval (milliseconds) value. A rate of 4000 ms is usually enough for these exercises.

5. Click on Continuous Refresh Qﬁ buttons for the watch view.
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6.1.4.1.6 Run the Code

1. Run the code by using the <F8> key, or using the Run button on the toolbar, or using Target -> Run on
the menu bar.

2. In the watch view, the variable phase should be set to 0.015625 (Q24). This variable denotes the
phase shift command to the PWMDRV_PSFB_VMC_SR module. Do not use a value of less than
0.005 for phase.

3. Apply an appropriate resistive load to the PSFB system at the DC output. A load that draws around
3A — 6A current at 12V output is a good starting point.

NOTE: For safety reasons it is recommended to use an isolated DC source to supply 400V DC input
to the board.

4. Power the input at J1, J2 with 400V DC.

5. Increase the phase command by setting phase to a higher value 0.1(say) in the watch view. The output
voltage should increase. Observe the output voltage carefully, this should not be allowed to exceed the
capabilities of the board. Keep in mind that when operating with a certain phase value if the load is
suddenly reduced, the output voltage will go up. Therefore do not make any sudden changes of load or
big increases in phase command when operating in build 1.

6. Observe the different ADC results in the watch view for different phase values.

7. Here is the watch view that corresponds to the operation of the system with a phase command of
0.705 (Q24) with an input voltage of around 400V and a load of around 6A at 12V output.

akch (17 3 RUEIS Ry
Yalue Address
= phase 0. 7049999533 Ox00005350@0atka Q-valus(24)
= SR_mode 2 0x0000530E@Data Makural
= dbAkoP _leg 32 0x00008316@0aka Makural
= dbPtod_leg 42 0x00005330C@Datka Makural
= auto_ DB 1 0x0000530E@Data Makural
= igui_\fbout 12.0635 0x00005326@0aka Q-¥alue{10)
= Gui_Ifb 0.275635 0x00005324@0ata Q-Walue{12)
= Gui_\fbin 397.5351 0x00005322@0ata Q-¥alue(s)
= Gui_Iouk 6.09375 0x00005525@0ata Q-¥alue(7)
= GUi_Pout 73,4844 0x0000552C@bata Q-Yalue(d)
= FaultFlg 0x0000832E@0ata Makural
= Ipri_trip 0x00005303@0ata ink Makural
! | |
Figure 38.
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8. The following oscilloscope capture shows the transformer primary voltage and the sensed primary
current seen under conditions described above.

50G5/5 || 7 340

220.000us OM points |

(11 May 2011]
|06:28:47

Figure 39.

9. By default the synchronous rectifiers are operated in mode 2. You may change their mode of operation
by changing SR_mode variable to 0, 1 or 2 from the watch view. Observe the change in amount of
input current being drawn and change in output voltage with different SR modes. You may also probe
the PWM waveforms driving the synchronous rectifier switches. Do not change between different SR

modes when operating at very low loads or when the output voltage is very low (less than 6V). In these
cases use the default SR mode 2.

10. Try different phase values and observe the corresponding ADC results. Increase phase in small steps.
Always observe the output voltage carefully, this should not be allowed to exceed the capabilities of
the board. Different waveforms, like the PWM gate drive signals, input voltage and current and output
voltage may also be probed using an oscilloscope. Appropriate safety precautions should be taken and
appropriate grounding requirements should be considered while probing these high voltages and high
currents for this isolated DC-DC converter.

11. Fully halting the MCU when in real-time mode is a two-step process. With the 400V DC input turned
off wait a few seconds. First, halt the processor by using the Halt button on the toolbar, or by using

Target -> Halt. Then click B button again to take the MCU out of real-time mode and then reset the
MCU.

12. You may choose to leave Code Composer Studio running for the next exercise or optionally close
CcCs.

13. End of Exercise
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6.2

6.2.1

6.2.2

Build 2: Closed Voltage Loop (Full HYPSFB in VMC Mode)

Objective

The objective of this build is to verify the operation of the complete VMC based HVPSFB project from the
CCS environment.

Overview

Figure 40 shows the software blocks used in this build. The PWM and ADC driver blocks are used in the
same way as in the previous build. A two pole two zero controller is used for the voltage loop. Depending
on the application’s control loop requirements some other controller block like a PI, a 3-pole 3-zero, etc
may also be used. As seen in the Figure 40, the voltage loop block is executed at 100 KHz. CNTL2P2Z is
a 2nd order compensator realized from an IIR filter structure. This function is independent of any
peripherals and therefore does not require a CNF function call.

100Khz
PWMDRV_PSFB_VMC_SR 1,2,4

100Khz

CNTL_2P2Z:1:

; PWMDRV_PSFB_Phase:n:

=s7

b=
(0]
T
=
<
=~
>

B2 PWMDRV_PSFB_DbAtoP:n:

—
Dmax aPWMDRV_PSFB_DbPtoA:n: 5

100Khz
ADCDRV_é4ch:1,2,3,4:

< Adc_Vfbout RItPtrA ADC AO

Adc_lfb RItPrB €«— ADC A2

O >

Adc_Vfbin RItPtrC C «— ADCB1

Adc_lout RItPtrD \€«— ADC B4

Figure 40. Build 2 Software Blocks

The five coefficients to be modified are stored as elements of the structure CNTL_2P2Z CoefStructl
whose other elements are used for clamping the controller output. The CNTL_2P2Z block can be
instantiated multiple times if the system needs multiple loops. Each instance can have separate set of
coefficients. Directly manipulating the five coefficients independently by trial and error is almost
impossible, and requires mathematical analysis and/or assistance from tools such as matlab, mathcad,
etc. These tools offer bode plot, root-locus and other features for determining phase margin, gain margin,
etc.

To keep loop tuning simple and without the need for complex mathematics or analysis tools, the
coefficient selection problem has been reduced from five degrees of freedom to three, by conveniently
mapping the more intuitive coefficient gains of P, | and D to BO, B1, B2, Al, and A2. This allows P, | and
D to be adjusted independently and gradually. These mapping equations are given below.
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The compensator block (CNTL_2P2Z) has 2 poles and 2 zeros and is based on the general IIR filter
structure. It has a reference input and a feedback input. For the voltage loop the feedback is the sensed
output voltage (Adc_Vfbout), while the reference input to the controller is a slewed version (VfbSetSlewed)
of the output voltage reference command (Vref). The transfer function is given by:

U(Z) _ bo+biz”' + bz

E(Z) l+aiz™ + a2z ©)

The recursive form of the PID controller is given by the difference equation:
u(k) =u(k —1) +boe(k ) + bre(k —1) + bae(k - 2)
where
bo=Kp+ Ki+ Ka
b =Ky, + Ki—2Ku
b2 = Ku
And the z-domain transfer function form of this is:
Uz by biz' biz® boz° bz b

E z 1 z! 22z 7

Comparing this with the general form, we can see that PID is nothing but a special case of CNTL_2P2Z
control where:

ar=-1 and a2=0 (8)

For the voltage loop these P, | and D coefficients are: Pgain, Igain and Dgain. These P, | and D
coefficients are used in Q26 format. To simplify tuning from the GUI environment (or from CCS watch
views) these three coefficients are further scaled to values from 0 to 999 (Pgain_Gui, lgain_Gui and
Dgain_Gui).

From the GUI environment the voltage loop can also be tuned using two poles (fpl, fp2), two zeroes (fz1,
fz2) and gain (Kdc). These parameters provide b2_Gui, b1_Gui, bO_Gui, a2_Gui and al_Gui coefficients
in 15Q10 form which are then converted to the five Q26 coefficients for the 2P2Z controller. Although not
recommended, b2_Gui, bl _Gui, bO_Gui, a2_Gui and al_Gui values may also be directly changed from
the CCS environment using watch views. Please refer to HYPSFB-Calculations.xls file for details on these
calculations. The equations for deriving coefficient values based on poles, zeroes, gain and switching
frequency are also clear from the GUI source file.

This project allows easy evaluation of both methods of loop tuning by providing the ability to easily switch
between coefficients during execution. This can be done by simply clicking on the 2P2Z(On)/PID(Off)
button on the GUI or changing the pid2p2z_GUI variable to 0 or 1 on the watch view from CCS. PID
based loop tuning (pid2p2z_GUI = 0) from the GUI environment was used as a starting point. Poles,
zeroes and gain corresponding to these PID tuned coefficients were then used as a starting point for
further loop tuning based on the second method (pid2p2z_GUI = 1). Much better results were then
achieved by changing poles, zeroes and gain from the GUI environment to tune for optimum dynamic
performance. By default coefficients based on these tuned poles, zeroes and gain values (pid2p2z_GUI =
1 — default) are used.

NOTE: This project allows easy evaluation of both methods of loop tuning by providing the ability to
easily switch between coefficients during execution. This can be done by simply clicking on
the 2P2Z(0n)/PID(Off) button on the GUI or changing the pid2p2z_GUI variable to 0 or 1 on
the watch view from CCS. PID based loop tuning (pid2p2z_GUI = 0) from the GUI
environment was used as a starting point. Poles, zeroes and gain corresponding to these
PID tuned coefficients were then used as a starting point for further loop tuning based on the
second method (pid2p2z_GUI = 1). Much better results were then achieved by changing
poles, zeroes and gain from the GUI environment to tune for optimum dynamic performance.
By default coefficients based on these tuned poles, zeroes and gain values (pid2p2z_GUI =
1 — default) are used.
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6.2.3 Procedure
6.2.3.1  Build and Load Project

To quickly execute this build using the pre-configured work environment, follow the following steps:

1. Follow Steps 1 to 2 exactly as in build 1. If you were working on build 1 the last time CCS was used,
the same workspace should open up with the project. If this is not the case, you can open the
workspace used for build1 by clicking File -> Switch Workspace and then navigating to the correct
workspace. If a workspace was not saved or got deleted, please follow steps 3 and 4 exactly as in
build1

2. Locate and inspect the initialization code specific to build 2 in the main file. This is where all the control
blocks are configured, initialized and connected in the control flow.

3. Select the Incremental build option as 2 in the HVPSFB-Settings.h.

NOTE: Whenever you change the incremental build option in HVPSFB-Settings.h always do a
“Rebuild All”.

4. Click Project -> “Rebuild All” button and watch the tools run in the build window.

5. Click Target -> "Debug Active Project”. The program will be loaded into the FLASH or RAM memory
depending on the project configuration. This project comes in only F2802x_FLASH configuration. You
should now be at the start of Main()..

6.2.3.2 Debug Environment Windows

It is standard debug practice to watch local and global variables while debugging code. There are various

methods for doing this in Code Composer Studio, such as memory views and watch views. Additionally,

Code Composer Studio has the ability to make time (and frequency) domain plots. This allows us to view

waveforms using graph windows.

1. If a watch view did not open when the debug environment was launched, open a new watch view and
add various parameters to it by following the procedure given below.

2. Click: View -> Watch on the menu bar.

3. Click the “Watch (1)" tab. If a watch view is already open from the debug environment saved for build
1, click on button in the watch view. A “Watch (2)” tab will open and you may then drag it to be viewed
in a window of your choice. You may add any variables to this watch view tab.

4. In the empty box in the "Name" column, type the symbol name of the variable you want to watch and
press enter on keyboard. Be sure to modify the “Format” as needed. The watch view should look
something like the following. Please note that some of the variables have not been initialized at this
point in the main code and may contain some garbage values.
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6.2.3.3

tatch (2) X

Mame Yalue Address
6= Gui_YfbsSet 2.0 00000832 3@ 0ata i -Yalued10)
(= Gui_WFbout -29.4277 0000053 26@Data i Q-Yalue(10)
= Gui_lIfb -3.33395 00000832 4@0ata i Q-Value(12)
()= Gui_Iout -211.719 0000053 25@Data i Q-Yalue()
)= Gui_vfbin -872.875 0x00008322@Data i Q-Valuels)
6= Gui_Pout 0.0 0x0000832C@0ata i Q-Yaluels)
)= phase 0.0 0x00008350@Data Q-Value(z4)

9= SR _mode 2 0000083 10@0ata i Matural
(9= dbAkoP_leg 20 0x0000830F@Daka i Takural
)= dbProa_leq 20 0x0000830E@Data i Matural
()= auto_DE 1 0x0000830C@Daka i Tatural
()= FaultFlg -13656 0x0000832B@Data i Matural
9= Tpri_trip 12089 000005303 @Data i Matural

()= Auto_Run O=00005305@Data int Tatural

ul

Figure 41.

Notice the additional variables in the watch view.
Gui_VfbSet is used to set the output voltage command.

Run the Code

Follow steps 1 to 4 of the build 1 Procedure to enable real time mode and continuous refresh for the
watch views and also for changing the continuous refresh interval for the watch view if needed.

Run the code by using the <F8> key, or using the Run button on the toolbar, or using Target -> Run on
the menu bar.

Apply an appropriate resistive load to the PSFB system at the DC output. A load that draws around
3A — 6A current at 12V output is a good starting point.

NOTE: For safety reasons it is recommended to use an isolated DC source to supply 400V DC input
to the board.

Power the input at J1, J2 with 400V DC.

By default Auto_Run is set to 1. If it is not, make it 1 from the watch view. The output voltage should
now start ramping up to 12V. This output voltage ramp up rate can be changed by changing the
variable VfbSlewRate.
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6. Figure 42 is the watch view that corresponds to the operation of the system with 12V at the output
with an input voltage of around 400V and a load of around 6A output.

Watch (1)

Marme Yalue Address Type Farmat
()= Gui_vfbet 12,1992 0x00003323@Data ink Q-Value{10}
(9= Gui_fhout 12,1943 Ox00003326@0ata int: O-Value(10)
B)= Gui_Ifb 0.273309 0=00003324@Data ink Q-Yalue(12)
()= Gui_lout 6.07031 0x00003325@Data int Q-Value{7)
()= Gui_fbin 398,781 0x00003322@0ata ink Q-Value(s)
()= Gui_Pout 74,1094 0x0000332C@0ata int 0-Yaluela)
()= phase 0.7145251632 0x00003350@0ata long Q-Yalue(24)
()= SR_mode 2 00000331 0@Data int Matural
()= dbatoP_leg 3z 0x0000830F@Data int Matural
()= dbPtoa_leg 4z 0x0000330E@Data int Matural
(9= auto_DE 1 0x0000830C@0ata int Matural
(9= FaulFlg 0 0:x0000332B@Data int Tatural
()= Ipri_trip 12089 0x00003303@Data int Matural
()= Auto_Run 1 0x00003305@0ata int Matural

|F____-I
Figure 42.

7. The following picture shows waveforms captured under this condition.

50GS7S Hfii?*ziﬁv"

| B
ops ‘ ‘wm points

Figure 43.

8. By default the synchronous rectifiers are operated in mode 2. You may change their mode of operation
by changing SR_mode variable to 0, 1 or 2 from the watch view. Observe the change in amount of
input current being drawn and change in output voltage with different SR modes. You may also probe
the PWM waveforms driving the synchronous rectifier switches. Do not change between different SR
modes when operating at very low loads (below 3A). In these cases use the default SR mode 2.
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9. Observe the effect of varying load* on the output voltage and input current. There should be virtually

no effect on the output voltage. Similarly observe the effect of varying the input voltage*. Again there
should be virtually no effect on the output voltage.

NOTE: Ensure that these changes are made within the abilities of the board as listed in Section 1.3.

10. Different waveforms, like the PWM gate drive signals, input voltage and current and output voltage
may also be probed using an oscilloscope. Appropriate safety precautions should be taken and

appropriate grounding requirements should be considered while probing these high voltages and high
currents for this isolated DC-DC converter.

11. Fully halting the MCU when in real-time mode is a two-step process. With the 400V DC input turned
off wait a few seconds. First, halt the processor by using the Halt button on the toolbar, or by using

Target -> Halt. Then click o button again to take the MCU out of real-time mode and then reset the
MCU.

12. Close CCS
13. End of Exercise
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7 References

For more information, please refer to the following guides:

1. UCC28950 600-W, Phase-Shifted, Full-Bridge Application Report (Literature Number SLUA560)

2. 600-W, Phase-Shifted, Full-Bridge Converter (Literature Number SLUU421)

3. H. Nene, “Implementing Advanced Control Strategies for Phase Shifted Full-Bridge DC-DC Converters
using Micro-Controllers” PCIM Europe 2011, Nuremberg, Germany.

4. HVPSFB-Calculations.xls — a spreadsheet showing key calculations for the HVPSFB project.
- .\controlSUITE\development_kits\HVPSFB_v1.1\~Docs

5. QSG-HVPSB-Revl.1.pdf- gives an overview on how to quickly run and experiment with the HYPSFB
project using an intuitive GUI interface.
. -\controlSUITE\development_kits\HVPSFB_v1.1\~Docs

6. HVPSFB_RevB-HWdevPkg — a folder containing various files related to the base board and Piccolo-A
controller card.
--\controlSUITE\development_kits\HVPSFB_v1.1\~HVPSFB_HWdevPkg\RevB

7. F28xxx User's Guides (http://www.ti.com/f28xuserguides)
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